OPENROADS
DESIGNER

EXERCISE
MANUAL

BUREAU OF DESIGN AND ENVIRONMENT

TECHNOLOGY POLICY AND

SUPPORT GROUP
DOT.CADD.GIS.SUPPORT®@ILLINOIS.GOV

llinois Department
of Transportation




Blank pages have intentionally been left in this document, in the event you wish to print it.



Survey and ROW Exercises Table of Contents

Chapter 1 - QuickStart for Geometry - Road

This chapter is provided by and property of Bentley, therefore pages 2-49 have been removed.
You can view the training material and files by going to the Bentley Learn Server at learn.bentley.com
and logging in using your Bentley IMS account credentials or following the link below and logging in.

Roadway Design & Modeling — Fundamentals Learning Path

Chapter 2 - Importing and Editing Survey Data

E2.1 Create a File and Import Data 50
E2.2 Explore and Configure the Drag and Drop Import Process 56
E2.3 Continue Importing Survey into Field Books 60
E2.4 Editing Survey Points and Linear Features 62

Chapter 2 Review 76

Chapter 3 - Using and Editing Terrain Models

E3.1 Terrain Model Review and Display 77
E3.2 Complex Terrain Models 84
E3.3 Add a Boundary and Modify 88

Chapter 3 Review 90

Chapter 4 - ROW, Parcels and Plats

E4.1 File Setup, Understanding the Interface, and Extracting Parcels 92
E4.2 Creating Parcels with Geometry Builder 97
E4.3 Create a Single ROW Plat or Plat of Highways 101
E4.4 Labeling the Plat 107

Chapter 4 Review 118

Chapter 5 - Creating a Parcel from Key-In

E5.1 File Setup, Understanding the Interface, and Extracting Parcels 120
E5.2 Creating Parcels with Geometry Builder 124
E5.3 Creating ROW with Geometry Builder 126
E5.4 Creating Temporary Easement with Civil Accudraw (Cogo Replacement) 127

Chapter 4 Review 131


https://learn.bentley.com/
https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=113539&aftkn=53463ea9-8d05-4f5b-bd4f-142f7f2a291b




Create a New

Document In

ProjectWise






How to create a new Document in ProjectWise

Navigate to the folder within ProjectWise that you want to create your document in.

From the menu at the top of the ProjectWise window select Document -> New -> Document.
ﬁ ProjectWise Explorer CONNECT Edition

Datasource  Folder  Document  View Tools Window Help
Mew kS Document... |
Open Dependency Map...
Open as Read-Only Multiple Documents
Open With.. Version...
Markup Advanced Wizard...
PDF Markup Mo Wizard...
View

Coion I _,7"\L.. CADData
In the Select a Wizard dialog that opens select the Advanced Wizard and then OK.

/ Select a Wizard

x
Document Creation Wizards
— OK
— |
Cancel
Mo Wizard Advanced
Wizard

[ Make this wizard the default choice

NOTE: If you do not receive the Select a Wizard dialog you will need to go to Tools -> Wizard Manager from the top

menu bar and reset the Default to -- no default wizard -- by clicking the Clear Default button. Then close the dialog and
restart the new document process.
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4. Inthe Advanced Document Creation Wizard, select Next on the Informational first screen
5. On the Select Target Folder screen, the folder that you are currently in within ProjectWise should be selected.
a. If thisis not the folder, you want to create the document in or is not selected then you will need to

navigate to the location you want to create the file in.

Advanced Document Creation Wizard
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Select the folder:

You should select the flder, where document(s) will be created.
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How to create a new Document in ProjectWise

6. Select Next to go to the Select a Template page. Here you will select the Seed file for the environment that you
are using from the Managed Workspace Seed file location.

Select a Template

<Back. o Cancel

7. Make sure that “Use ProjectWise document as a template” is checked and the pick Select at the end of the line
to select the file.

8. Inthe Select Template Document dialog, navigate to
IDOT Standards\CADD Standards\IDOT\Environment Version\Organization-Civil\IDOT_Standards\Seed
and select the Seed file that you need and click Open. Back on the Select a Template page select Next.

£ Select Template Document x

Select

nnnnnnnn

M00Tng dgn PowerGEOPAKSS!  IDOTengc
7Ba00TengD.dgn PowerGEOPAKSS!  IDOTeng3

Note: Once you do this one time then the Seed file will be listed in the “Select from recent used templates” area shown

in the screenshot above.
9. On the Document Properties page set the following information and the select Next at the bottom.
a. Name: Make sure and adhere to the standards set in the CADD Manual
b. Description: Will make it easier to understand what piece of the project each file contains

c. Application: OpenRoads Designer

<Back Cancel




How to create a new Document in ProjectWise

10. On the Define Secondary Document Attributes, there is nothing that you need to set at this time. Click Next at
the bottom.

Wt Saim i

v Dt o

O i Fomat |

Drving Satun I
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11. On the Create a Document page, all the settings that you have selected, or set will be displayed for your review.
Select Next at the bottom to create your document and then click Finish on the Completing the Advanced
Document Creation Wizard page to close the Wizard.
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Your document has now been created in the location that you specified and associated with OpenRoads Designer.
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EXERCISES - Chapter 2 - Importing and Editing Survey Data

E2.1 - Create a File and Import Data

Design File Setup - Outside ProjectWise
1) Start OpenRoads Designer
2) Setthe Workspace and Work Set
e The Workspace and Work Set define standards that are used by the software. The Workspaces are set up
during the software installation. In this training we will be using the District WorkSpace, but this could
change depending on software and Workspace Standards updates.
o The following steps will set up the Workset you will be using throughout this training. Internally within IDOT
your CADD Manager will take care of setting up the Workset for the project and everyone’s use.
3) Select District from the WorkSpace pulldown menu then select Create Workset from the WorkSet pulldown

menu.

WorkSpace WorkSet WorkSpace ~ WorkSet

No WorkSpace * No WorkSet District ~ _Template for New WorkSet ~

o o}
| ?] Recent Fil t
Custom Configuration = _Template for New WorkSet
. is€ You haven't ¢ ta

Aerial Surveys

Bridge

District «

IDOT Consultant B

rowse

Winnie Talhan s

== Create WorkSpace

1 = - H
}:_,} Configuration Assistant

1 -
; DWG WorkSet Wizard
fers] » == Create Workset...

4) The Create Workset Dialog Box will open, fill in and select the following:
e Name: D69621
e Description: IL97/125 Reconstruction
e From the Template dropdown selection box select: _Template for New WorkSet and click OK to continue.

Create WorkSet X

Name:  D69621

Description: 1L 97/125 Reconstruction

Template: _Template for New WorkSet v Create Folders Only

= Add a Custom Property ~

Folder locations

Root Folder:

Design Files:
Standard Files:
Standards Subfolders:

ProjectWise Projects

Browse...

OK Cancel
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5) On the right side of the screen, you will see “Properties” select it and then select “Advanced Properties”. Fill in
the Advanced Properties in the Edit WorkSet dialog with the following:

Edit WorkSet X

Contract No.: C94598

County: Sangamon

FAP Type: P.

Route: IL97/125

Scale: 1”=50’

Section: (52X63)
SHEETTITLELINE1: IL97/125
SHEETTITLELINE2: Plan Sheets

Name:

Description:

IL 97/125 Reconstruction

Contract No.
County

FAP Type

Route

Scale

Section
SHEETTITLELINE1
SHEETTITLELINE2

Structure No.

94598
Sangamon
P.
IL97/125
1"=50"
(52X63)
IL97/125
Plan Sheets

SN.

= Add a Custom Property ~

6) Click OK to save and exit the Edit WorkSet dialog box (not shown). These Properties will automatically fill in the
Title Block on all sheets in this project. This is the current workflow, this will be changing with future releases of
the software and IDOTCAD Environment, training will be provided at that time.

7) Select New File and navigate to the location where you unzipped the dataset files. Name the new file
PickupSurvey.dgn. Click Browse and select the IDOTeng3d.dgn Seed file and click Save to close the dialog box

and open the newly created file.

Design File Setup - Inside ProjectWise

Specific instructions will be presented during class on how to utilize the Managed Workspace within

ProjectWise. Your CADD Manager will also have more information if needed as well as be setting up the

WorkSet folders for the entire Project.
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Set the Geographic Coordinate System

Before we import the Survey data, we need to ensure the Geographic Coordinate System (GCS) is set correctly.
This enables the software to make automatic adjustments so data from different systems will mesh seamlessly.
Surveyors more than anyone can appreciate the importance of setting the correct Geographic System.

1) Select the Survey Workflow from the drop-down menu. Survey | &
2) Under the Utilities tab, in the Geographic toolset, select the Coordinate CpenioacsModelng

Fro Y OpenRoads Drawing Production

System tool. N ST
{; X . Geotechnical
3) Select From Library icon. "« C'I'Sgr;'f'cg:_zte Reality Modeling
4) In the Library Dialog click the Search tab and type lllinois in the “Search Drawing
Modeling

Text” and hit Enter.

Visualization

Drainage and Utilities

% Select Geographic Coordinate System

Library Search
Search Text ‘Ilhnois\ | [ FindNew ]
(® Any \word O All \words
Key Name Description Units Projection EPSG Code Datum Elipsoid
it
< >
Cancel

5) Click on the Units column header to sort by it.
6) Select all the “Key Name” Coordinate Systems with units of “US Survey Foot” (Shift pick the top and bottom one)

% Select Geographic Coordinate System

Library  Search

Search Text ‘Ilhnols

(® Any Word O All Words
Key Name Description Units/\ Projection EPSG Code Datum Hiipsoid
ILHP-E Use HARN/IL.IL-E instead - HARN lli... METER ~ TM 2750 HPGN GRS51980
NSRSO7.IL-W NSRS 2007 llincis State Plane, West METER TM 3530 NSRSO7 GRS51380
NSRSO07.IL-E NSRS 2007 linois State Plane, East .. METER M 3528 NSRS07 GRS1380
IL83-wW NADS3 llinois State Plane, West Zon METER TM 26572 NADS3 GRS1580
IL83E NADS3 llincis State Plane, East Zone... METER ~ TM 26971 NADE3 GRS1380
1L83/2011-W NSRS11(NADE3/2011) lincis, West .. METER  TM 6456 NADB3/2011  GRS1980
1LB3/2011-E NSRS11{NAD83/2011) linois, East METER TM 6454 NADB3/2011 GRS1580
EPSG:102271 NAD 1383 HARN StatePlane llincis ... Meter ™ 102271 HPGN GRS1380
NADB3{HARN) / llinois East ftUS) US Sur. ™ 3443 HPGN GRS51380
NADB3HARN) / llinois West ftUS) uUssur.. TM 3444 HPGN GRS1380
NADS3 / llincis East ftUS) usSur.. TM 3435 NADE3 GRS1380
NADS3 / linois West ftUS) US Sur. ™ 3436 NADS3 GRS1580
NAD 1383 StatePlane llinois West FI..  USSur..  TM 102672 NADE3 GRS1380
NAD27 / lincis East US Sur. ™ 26771 NAD27 CLRKEE
NAD 1383 StatePlane llinois East FIP... USSur.. TM 102671 NADB3 GRS1380
NAD27 / llincis West usSur.. TM 26772 NAD27 CLRKEE
>
Add To Favorites
0K Cancel

7) Select Add to Favorites button at the bottom to add your selection.
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8) Select the Library tab at the top of the Dialog.
9) If “Favorites” is not expanded, click the plus (+) sign next to it to expand. This will show you the coordinate
systems that you picked that apply only to lllinois.
e Also notice that there is an IDOT and IDOT_2021 folder listed with the Favorites folder. The IDOT folder lists
the original District 8 LDP zones per county. The IDOT_2021 folder lists the 33 new LDP zones.

B Select Geographic Coordinate System

Library  Search
B Favorites

Coordinate System a o~

26771 - NAD27 / lincis East :
12672 - NAD 1383 StatePlane llincis West FIPS 1202 Feet EPSG:102672
NAD 1983 StatePlane llincis |

Transverse Mercator

126772 - NAD27 / lingis West.

PSG:102671 - NAD 1983 StatePlane llinois East FIPS 1201 Feet
P5G:3444 - NADEI(HARN) / llinois West ftUS)

PSG:3443 - NAD83(HARN) / llinois East ftUS)

PS5G:3436 - NAD83 / llincis West ftUS)

PSG:3435 - NAD83 / llincis East ftUS)

0

ESRI PRJ [AGIS]
US Survey Foot
90°10°00.0000"W
36°40°00.0000"N
0.99994118
2296583.3330
0.0000

Positive X and Y
92°15'00.0000"W

IDoT
IDOT_2021
Library

-

87°45'00.0000"W
36°00°00.0000"N
43700°00.0000"N

-~

NADE3

North American Datum of 198]
US Defense Mapping Agency.
NADE3 - no shift required

oo

10) Double Click on EPSG:102672-NAD 1983 StatePlane lllinois West FIPS 1202 Feet under your Favorites.
11) Close the Geographic Coordinate System Dialog.

Import the Survey Data
Workflows segment tools into discipline specific groups and streamline the interface. Notice how the tabs
change to survey specific categories. Each tab further segments the survey tools into a task-based interface.
1) Select the Survey Workflow from the drop-down menu. The survey tools and commands are in the Survey
Workflow.

2) Under the Home tab, in the Primary toolset, select the Explorer tool.

w4 Survey @ odE =k X
m Home Field Book Analyze Edit Terrain Geometry Drawing Production Drawing Utilities Collaborate View

@ None * || Default v ;Q r: B-=- k 1 . ' ).

B ~ @] sty (&,

.= = =3 = = Expl Attach - El t Reports Civil Corridor i
EL 30 =0 7@ PO Tools > 7 + & ~ | Selection =" Analysis+ Reports~ plimview It

Attributes Primary Selection Model Analysis and Reporting

3) Expand the Survey pane in Explorer.
o Note: The Explorer tool is where we can access and organize the survey data directly.

4) Right-click on Field Books under Survey Data\Default and select New. Once you create a new Field Book this file
is now considered a Survey File.

Explorer v I X
Drainage and Utilities Model Survey
Y tems: |1 OpenRoads Model & Sheet index OpenRoads Stajaaalai s

QO®™P: ¢ lems OpenRoads Model & Sheet Index Ope w View 1- Top, Defa
l - Drainage and Utilties Model Survey | ¥ tems OpenRoads Model & Sheet Index OpenRoads Standards | e 1
Searc B SVEY & -4
QO @LO: Drainage and Utities Model Survey . 2
[Seart QL.

| Search

i
«

‘o

> v @ Survey Data

4 v dJ Survey Data

4 v [ Default

Create Terrain Model From Field Book Selection Set
v Yy Filters
New...

v €) Multimedia Files @ Propertes k
O Zoom

. Isolate

Clear Isolate

m= Details

& Properties
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5) Expand Field Books and right-click on Field Book 1 and select Properties. Rename Field Book 1 as IL 125/97 and
hit tab to accept the name change.
6) Right-click on the Field Book IL 125/97 and the select Import -> File.

Explorer v ax
¥ hems OpenRoads Model & Sheet Index OpenRoads Standards
Drainage and Ukities Model Survey
QQL.

@ Properties (Survey) _ x
[Searct 5]

4 () Selection (1)

4 ¥ [ Survey Data

4 v [ Defauit v ] Field Book 1
P Field Book:
) ‘” _— @ Properties (Survey) - X
Create Adjustment
vy Fil
v e Create Terrain Model... 4 @ selection (1)
ort To ,
y k Select
Delete
Import Create Adjustment
S| Rroperbes Create Terrain Model..
(<]
4 Zoom Field Book Export To »
W lsolate
[, 1L 97/125 Delete
Clear Isolate k — 0 I
N Co 5 =
55 Detais 0 k [ 2 File...
@1 Properties 0 b @] Properties File Using Text Import Wizard... ———
g Field Book B Zoom TrimbleLink.. N
0 Name - Isolate Leica DBX...
Control Points Gl Bentley Survey Format...
0 Features From Current Graphics
0
0
0

7) Navigate to the location where your project is saved and open the Survey\IL 12597 folder. In that folder locate
the “10013C.asc” file and click on it, then pick Open. Select IDOT_6 for the Data Format and click Apply.

2 [ = | wm2se7 -

“ Home Share View

» u & cut x !‘ 3 New item ~ ﬂ Open - [ selectan
Wi Copy path v £ | Easy access ~ Edit Select none
Pinto Quick Copy Paste Move Copy Delete Rename New Properties o
access [7] Paste shortcut to to folder - @ History 5 Invert selection
Clipboard Organize New Open Select
<« v P <« Jamie Test Project (IL 97)Importing Survey Data > Importing and Editing Survey Data > Survey > IL12597 v O Search IL1259°
~
& Downloads # A Name Date modified Type Size
] Pictures * [ 10013C.as¢ ASC File 31k8
I Desktol ; ASC Fil 40K
P L ] 10013E.asc Type: ASC File SC File KB
DrewTimeSheetsETC |_] 10013F.asc Size: 30.2 KB ASC File 21KB
Jamie Test Project (IL 97)Importing Survey Data [] 10013G.as¢ Date modified: 12/14/20181:38PM g ASCFile 118
PowerGEOPAK_SS4 ] IL1251L97.asc 2/1 ASC File 34KB
[7] in2597_A_)sS.asc ASC File 9KB

« Creative Cloud Files

8) In Explorer, left click the arrow next to Survey Data to expand the tree to see other survey data folders.
e Under Field Books is where the imported survey data is stored.
e The data structure can be organized to fit your operational needs. i.e. Do you need a single “job” where all
the collected field data is stored? Or, do you need to separate each and every collection into its own book?
It is up to you to decide what a Field Book contains.
9) View the newly created Field Book.
e Left click the arrow next to Field Books to expand the Field Books folder to review IL 125/97.

Explorer v @ x
¥ ltems OpenRoads Model
& Sheet Index OpenRoads Standards
Drainage and Utilities Mode! Survey

QL.
l5earm LRy
4 v [ Survey Data
4 v [ Default
4 v [} Field Books
4 L]
> v % DataFiles
> ¥ ¥4 ALL Point Features
> v £ ALL Linear Features
v % ALL Control Points
v/ T2 All Setunc
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10) Review the imported points and linear features in IL 125/97.
e Left click the arrow next to All Points Features to review the imported survey points.
e Left click the arrow next to All Linear Features to review the imported linear features.

Note: If you wish to rename IL 125/97, right click on that Field Book and select Properties. Here you can modify
the name in the Name field. At this point it is important that all the resulting survey data is now contained
within this DGN file. There are no external files and there is no need to ensure synchronization between the
“data” and the resulting graphics or terrain. The resulting graphic elements contain the “intelligence” and
“know” certain survey properties such as Terrain Model Attributes (Spot, Break Line, Void, None, etc.) and how
they should display, as well as other properties that, in the past, were controlled by external files.

Review imported survey data
1) Use the Fit View tool to see the resulting elements that were imported. E

2) The survey points and linear features are now mapped into the DGN file. For this course, the terrain model is not
built automatically as part of the import process. You also have the option of building the terrain model as part
of the process, we will discuss this option later.

3) Zoom into the terrain as necessary and select one of the 664 linear features (white dashed lines) using the
Element Selection tool.

4) Hover your cursor over the linear feature until the Context Menu appears and then select Properties to review
the properties of the linear feature.

Note: all the survey attributes assigned to this feature (Name, Field Code, Zone, Terrain Model Attributes,
Feature Definition, etc.) The symbology of the survey points and linear features is controlled by the Feature
Definition. The Feature Definition also controls how the survey data is defined in the resulting terrain model

(i.e., Spot, Break Line, Void, etc.) For example, a field code named 6659 is assigned a Feature Definition called
6659. This Feature Definition sets up the terrain model attribute for this field code and the symbology for how it
will be displayed once imported into the DGN file.

@1 Properties - X

4 %5 Elements (1)

N 6659

Determine By Feature Definition

s O (al 270,016
evel: Topo_Point SPC Cell nnsor
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E2.2 - Explore and Configure the Drag and Drop Import Process

In the following sections, you will examine how the drag and drop process of survey data functions and how it is
configured in the Survey Settings. The first time you witness the drag and drop process you might be mystified as to how
it functions. It just processes the file automatically without (apparently) any user interaction. You might find that a bit
unnerving as prior workflows required more user input during the processing of data, and you might feel as though this
process is out of your hands. This is in fact by design. The drag and drop process was developed with the end user in
mind. Once you configured to your workflow/specific file types, it is a simple matter for you to process datasets quickly,
efficiently, and most importantly to a consistent standard.

Note: that at NO TIME will any of the survey tools/processes write back to your source data (raw data files).

Review Terrain Model Survey Settings

A Terrain Model can be automatically created as the data is imported and processed. One benefit to this is that
the resulting Terrain Model is dynamically linked to the survey elements. Also, if/when additional data is added to
the field book the terrain model is automatically processed and updated. While this is very different in its approach
to previous workflows it is very powerful and removes any issues with outdated terrain models or syncing the survey
data back to a Terrain Model. In this section, you will learn about the Terrain Model Survey Settings.

1) Open/ Continue in the PickupSurvey file.

2) Select the Survey Workflow from the drop-down menu. Under the Home tab, in the Primary toolset, select
Explorer if it is not already open.

3) Navigate to the OpenRoads Standards section and expand the PickupSurvey.dgn under Standards. Right-click
on Survey Settings and select Properties.

4) Expand the Survey Settings in the Properties window to where you see “IDOT Survey Settings” and select it.
Select the Terrain Model section to expand it and review the options.
e Create Terrain Model for All Field Books: Toggles the automatic Terrain Model Creation on and off.
o Name: Here you can define a default name for the Terrain Model (user configurable).
e Terrain Feature Definition: Define the initial Feature Definition assigned to the Terrain Model.
e Edge Method: Here you can specify the edge method applied to the terrain model.
e Length: Applies if Edge Method is set to Max Triangle Length (user configurable).

Recall that when we imported the survey data the terrain model was not created automatically, this happened
because the “Create Terrain Model for All Field Books” was set to False. If you want the terrain model to be
created upon import toggle this option to True.

Also, notice the default name AllFieldBooks is set here as well as the default Feature Definition for the terrain
model.

Vi @ @] Properties (OpenRoads Standards)
@ tems | OpenRoads Model & Sheet Index
Survey.
OpenRoads Standards | Drainage and Ltites Model

)YQ e 4 A Survey Settings 4 A Survey Settings

e

2] &

4 [ Selection (1) 4 (D Selection (1)

4 %@ Standards

General Settings Data File Parsing

Points Adjustment Defaults

Linking Codes Elements Symbology

- IRAIRAIRS

Data File Parsing

in Model for All Field Bool False
AllFieldbooks

Adjustment Defaults

S| ¢|¢([c| €| €| ¢
-
8
s
S
g
&

Elements Symbology Terrain Feature Definition Existing_Boundary
Edge Method None
Terrain Model Length 1000.0000
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Important notes about Survey Settings: In the IDOTCAD_ORD workspace, the Survey Settings are configured in

a DGNLIB file (surveysettings.dgnlib).Once survey data is imported these settings are automatically copied from

the DGNLIB into the current file. This allows settings to be easily managed across a network.

Review General Settings and Create Survey Log File

1)

In the Properties dialog under IDOT Survey Settings expand the General Settings section. If the options are

greyed out, you are in the State Standards and you need to be in the Properties for the file you are working in.

2)

Click on the field next to the Create Log File field and select TRUE to enable logging. When set to TRUE a log file

will be created that tracks changes and edits. The log file is named Default Log and it will be created in the

location of the currently opened design file. The log is a simple ascii file and can be reviewed with Notepad.

3)

i1 Properties (OpenRoads Standards)

Collapse the General Settings section by clicking the up arrow.

General Settings

Creste Log File True
Apperd Netes 16 Attributes. Troe
Apperd Netes 1o Descripticn  True

False

Beply Drawing Scale To Fixed C
M True:

Bitribute Overrides
Validasing Rules

Foints

4 [ survey Sertings

& IDOT Survey Settings

General Settings

ibutes
Agpend Notes 1o Deseriplion
Apply Drawing Scale T Fixed Cel-ramser

T

Use VBA Macros
'vba Festure Macros.

True:

Ltiribute Overndes
alidating Rudes

Points
Linking Codas

Data File Parsing
Adjustment Defaults
Elements Symbology

Terrain Model

] Properties (OpenRioads Standards) - ®

) Selection (1)

# |8 Survey Sentings

&P IDOT Survey Settings

Review Linking Codes

General Settings.

Attributes
Append Moles 1o Descriphicn
Apply Drzwing Scale Ta Fixed Cel False

Use VBA Macros True

Vba Feature Macros
Setribute Ovemdes
Validating Fules
Foints

Linking Codes

Data File Parsing
Adjustment Defaults

Elements Symbalogy

LK 2IK 2IK BN MR 4

Terrain Madel

Linking Codes will be discussed at length in a following course. But, for now, it is enough to know they are

entered in the field during the collection process and utilized by the software to create Linear Features (formally

known as Survey Chains). Since linking codes are very likely to be a section you will want to customize, we will take a

closer look.
1)
2)

Expand the Linking Codes section.

might stretch across the screen).
3)

the right. Left click on the icon to open the LinkCodes Editor.

@1 Properties (OpenRoads Standards) - X

Notice as you move the cursor over the field to the right of the Link Codes field. The field expands (in fact it

Ignore the pop-up field and left click to edit the field. The field should now show a small icon with three dots to

4 @ selection (1)
4 [A Survey Settings
& IDOT Survey Settings

General Settings
Points v

Linking Codes PN

Space Is Required Between Field Code ; False

Linear Feature Linking Method By Field Code
Linear Feature Linking By Linking Codes
Linear Feature Force Curves to LineStrir False

Feature Exclusions

Data File Parsing
Adjustment Defaults

Elements Symbology

IRIIRIIKS

Terrain Model

@] Properties (OpenRoads Standards) - X LinkCodes b
4 (D) Selection (1) ) " x o © By
W 4 >
4 @ survey Settings Accept = Add Delete = Use Exclude & Reset
GRS vy e Use LinkCode | Alpha Numeric ~
» True + | None None 0
True Start 1 1
General Settings v True StartPC 12, 2
P v True ArcPC 3
T G ~ True NonTanPC 5; 4
True ArcSingle 1 5
Link Codes <LinkCodeStjucts><LinkCodeStruct col..] ——
Link Code Position Before Point Field Code True ArcToArc 9. 6
Best Match Field Code True True NonTanPT 6 7
Space I Required Between Field Code  False A 4
Linear Feature Linking Method By Rield Code L ""CPT = :
Linear Feature Linking By Linking Codes True ArcToggle 8. 9
Igmear F:{ulve Force Curves to LineStrir False True End 2 10
cots Bechnions True CloseShape  10. n
Data File Parsing v True Close 7 12
Adjustment Defaults v True CircleDiameter CD* -1
oo S True CircleRadius CR® -1
True RectangleWidt RECT -1
Terrain Model & True TapeDistance DIST -1 v
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The first thing to notice is the menu bar at the top of the dialog. This is used to Accept, Add, Delete, Use, Exclude or
Reset codes in the list.

LinkCodes X

© DO X O @ G
Accept | Add Delete = Use Exclude | Reset

Below the menu bar is the editing field. Each linking code is represented on a line, the columns set the attributes for
each linking code.

e Use: Determines if the code is processed or ignored. Use LinkCode Alpha Numeric ~
e LinkCode: A pick list to define the attribute applied. > | True v ';0“'3 :“Oﬂe ?
X . . lrue tart -
e Alpha: A user defined code (alpha) entered in the field. True StartPC 12 B
e Numeric: A user defined code (numeric) entered in the True ArcPC 3. 3
field True NonTanPC 5. 4
: True ArcSinale 1. 5

4) To edit a field, left click in it. Columns Use and LinkCode will display a pick list of Alpha and Numeric and allow
manual edits.

5) Close the dialog box by clicking the X. Since the settings are saved to the current drawing, saving the settings will
not affect later modules. If you do not click the Green “Accept” check, then any and all changes you have made

will be lost.
6) Collapse the Linking Codes section by clicking the Up arrow.

@1

4 () Selection (1)
4 [A Survey Settings
& IDOT Survey Settings

General Settings v

Points -

Linking Codes @

Link Codes <LinkCode Structs><LinkCodeStruct code™— HHFEFIR
Link Code Position Before Point Field Code | Gollap=e Group
Best Match Field Code True

Space Is Required Between Field Code s False

Linear Feature Linking Method By Field Code
Linear Feature Linking By Linking Codes
Linear Feature Force Curves to LineStrii False

Feature Exclusions

Data File Parsing
Adjustment Defaults

Elements Symbology

L IIEAIEAIRS

Terrain Model

Taking the time to review these settings and tailor them to your specific workflow will be critical for the successful
utilization of the software

Review Data File Parsing

In this section, you will learn how to review the Data File Parsing settings and how they relate to the imported
IL12597 file we imported previously. The main advantage of the Drag and Drop process for importing field survey
data is the reduced workload to the end user and consistent processing results. The settings under the Data File
Parsing section really drive that functionality and merit some attention. This is key to configuring the Drag and Drop
functionality for your environment.

When files are processed, the software first looks at the file extension to determine how to process the file. If
several definitions (rows) are configured the same (meaning same extension in filter field) then a dialog will popup
during processing requesting clarification on how to proceed.
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1) Expand the Data File Parsing section under Survey Settings for your current file.
2) Left click in the field to the right of the Data Import Items label.
3) Left click on the small icon with three dots to open the Data Import Items Editor

e The top menu is like the one for previously discussed with Linking Codes in appearance and operation.
Note: As before, closing the dialog without clicking the Accept button will lose any edits made.

4) Scroll up and down the list to review all the various file formats. Close the Data Import Items dialog.

@1 Prop

5 (OpenRoads Standards) - X @1 Properties (OpenRoads Standards) - x
4 s
4 (@ su

urvey Settings

Data Import Items

General Settings General Settings

v v o 0 X |0 O | %
— v e . Accept | Add Delete | Use Exclude & Reset
s . s . Use | Owner Title Filter | FileTypeln | FileTypeOut| Exect
e a o N » True | Delivered Efbp Control File “ctl  EfbpControl None
i s ) lehecsing] Irue  Delivered MX Control File “inp  MxControlN None
almport Structs><Datalmport o T <Datalmport Structs><Datalmport: " -
Sl almpert Sucte><Detakapon St o e Detoleport Iracteo-Dutslmpor S Tree  Delivered Neutral File xnf  NeutralXNF  None
Subs o Tree  Delivered Leica DEXFile “xcf LeicaDBX  None
Descripton Sepaator Tree  Delivered Trimble Link Engine File ~ “job  TrimbleLink None
= Adribute Separator True  Delivered Field Genius File “dbf  FieldGenius None
Adjustment Defaults v Adjustment Defaults v Tree  Delivered Land XML File “xml LandML  None
Elements Symbology v Elements symbology v
Terrain Model v Terrain Model v

Review Settings for Processing Observation Data

The next two sections deal with settings used to process observation files and define symbology for control
elements.

1) Expand the Adjustment Defaults section.
o Note the options the software offers to process observation files.

@] Properties (OpenRoads Standards) X
4 [J Selection (1)
& 10T Survey Settings
General ettings v~
Points S
Linking Codes v
Data il Parsing v
Adjustment Defaults -~
Least Square
Do Not Use
1.0000
False
True
0.0100
50000
10.0000
0.1000
0.0300
).0000
g const 0.0100
etims M AO0 M

2) Once you are finished reviewing the options, collapse the Adjustment Defaults section.
3) Expand the Elements Symbology section.

e This section allows you to define the appearance of observation elements using Element Templates.

1 Propertes (OpenRoads Standards)

x

4 (3 selection (1)
& IDOT Survey Settings

General Settings
Points

Linking Codes
Data File Parsing

Adjustment Defaults

B ¢| <) <] <) ¢

Elements Symbology

Observation Element Template
Control Point Element Template
Setup Element Template
Traverse Element Template

HEE

Terrain Model v

4) Once you are finished reviewing the options, collapse the section. Depending on your collection process these
sections may or may not be applicable to you.
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E2.3 - Continue Importing Survey Data into Field Books

1) Let’s continue importing the rest of the data into IL125/97 Field Book. Open / Continue in the PickupSurvey.dgn

file.

2) Select the Survey Workflow from the drop-down menu. Select Explorer, located on the Home tab in the Primary
toolset if it is not already open.

3) In Explorer, under the Survey tab, navigate to Survey Data\Default\Field Books\IL 125/97. Right-click and select
Import -> File Navigate to the location where your project is saved and open the Survey\IL 12597 folder.

Exj v 3 X
o ? » View 1- Top, Default
¥ lems OpenRoads Model & Sheet Index 1 ® 00
=R -2 PP«
OpenRoads Standards Drainage and Ltiities Model =~ cBal ' ~ )
Survey
QQapl.
- P|R
4 ¥ @ sureyData
4 v [ Defauit
4 ¥ J Field Books
>

vy Filters

v @ Multimedia Files

File...
File Using Text Import Wizard...
Trimt

4) Select the files 10013E.asc, 10013F.asc, 10013G.asc, IL 12I1L97.asc and IL12597_A_JJS.asc, and select Open.
5) Select IDOT_D®6 in the Data Format box that pops up and select Apply All.

NOTE: Files may need to be imported one at a time

Data Format: 10013F.asc X

9 @
Apply | Apply All

IDOT_D2-Ascii-Space
IDOT_D2-Control
IDOT_D5-Quad-Codetab
| IDOT D6

6) After you have imported all the files do a Fit View to see the additional data.
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Continue Creating Field Books

In this section you will continue to create a field book. With a pickup survey like this it is better to separate all your

data into various field books so that your terrain models will be cleaner.

1) In Explorer navigate to Survey Data\Default\Field Books. Right-click on Field Books and select New.

N A X .o op, Defaut

R-x-|4 2900

¥ lems OpenRoads Model & Sheet Index
OpenRoads Standards Drainage and Lkilities Model
Survey

[Search PR

4 v d Survey Data

4 v [ Default

v Yy Filters

v/ € Multimedia Files

2 Zoom

Create Terrain Model From Field Book Selection Set
New...

@] Properties

Isolate
Clear Isolate
2= Details

@] Properties

2) Expand the Field Books folder and right-click on Field Book 1 and select Import -> File . Navigate to the location

where your project is saved and open the Survey\Field Book 1 folder. Select all the files in this folder and click

Open to import them.

Explorer v ix
@ tems || OpenRoadsModel & Sheet Index
OpenRoads Standards || Drainage and Utities Model
Survey
Q@eL.

= e ¥

4 ¥/ @ SurveyData
4 ¥ [ Defauit
4 W [) Field Books
> ¥ @ 2s/e7
I
v Yy Filters

v @ Multimedia Files I
xport To

Delete
Import
W] Properties
2 zoom
Isolate
Clear Isolate

85 Details

@1 Properties

Create Adjustment

Create Terrain Model..

= View 1 - Top, Default
5%+ 4 2 PREAD 6

File...

File Using Text Import Wizard...
TrimbleLink..

Leica DBX...

Bentley Survey Format..

Features From Current Graphics

3) Select IDOT_6 in the Data Format box that pops up and the select Apply All.

4) After you have imported all the files do a Fit View.

5) Repeat the steps above to create a new Field Book named Field Book 2.

6) Right-click on Field Book 2 and select Import -> File . Navigate to the location where your project is saved and

open the Survey\Field Book 2 folder. Select all the files in this folder and click Open to import them.
7) Select IDOT_6 in the Data Format box that pops up and select Apply All.

8) After you have imported all the files do a Fit View.

9) Continue to create and import Field Books 3 through 14.

10) Create two additional Field Books. Right-click on each, select Properties and rename them Farmingdale Rd and

Benchmarks and Pipes. Import the corresponding “.asc” files from the folders with the same names.

e We also have a field book that we will create and import in the Right of Way section.
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E2.4 - Editing Survey Points and Linear Features
Linear Features are created during the import process based on settings within the Survey Settings under the
OpenRoads Standards, specifically the Linking Codes section. When set to By Field Code the software honors those

codes entered in the field. Understanding how those codes are processed will give you greater understanding of the
end results.

Linking Codes ~
Link Codes <LinkCode Structs><linkCodeStruct coc
Link Code Position After Point Feld Code
Best Match Field Code True
Space Is Required Between Field Cot| True

e By Field Code -

Linear Feature Linking B d Cod
Feature Exclusions By Consecutive Field Code
|Connect All Matching Field Codes

Data File Parsing

| w

When field survey data is processed, Point Codes are examined to see if there is a match within the Feature
Definitions.

If there is no match, then the last character is ignored, and the resulting code is compared again to the list.
This is referred to as Best Match. If a match is found, all points are coded the same.

Once the Feature Definition has been established Linking Codes are searched for.

Linear Features are then generated based on Linking Codes AND the order in which the points are collected
in the field.

Three Types of Linear Surveyv Elements

1.
2.
3.

Linear Feature: These are automatically generated as described above.

Point List Linear Features: These are lists of points which can be manually edited and rearranged.
Graphical Linear Feature: This is simply a graphical element. All ties to survey data have been removed.
Please note this is a progressive demotion and cannot be reversed (other than by that session’s undo
process).

* Automatically Generated within the software based on settings
and field collection.

2o ® “Smartest” edited by modifying the attributes of the element.

* Similar to legacy Survey Chains.
* Points in list can be edited manually.
* Not as smart, but still honors point attributes.

Point List

Linear Feature

* All links to Survey information removed
el ® “Dumb” graphics.
Linear Feature

OpenRoads Designer CONNECT Edition Page 62 of 131
Chapter 2 — Importing and Editing Survey Data — EXERCISES



Illinois Department of Transportation
Technology Policy and Support — CADD Support Unit

Editing Linear Features

In this section you will examine several ways to edit Linear Features.

1) Continue in file PickupSurvey.dgn.
2) Turn off all field books except for 1L125/97 Field Book by selecting the Check Box in front of the name.

Explorer v X
@ fems | OpenRoads Model & Sheet Index
OpenRoads Standards || Drainage and Ukitties Model
Survey
QQep.

[Foor plo v

4 v [@ SurveyData
4 v [ Default
4 V) Field Books
> v @ wser
> J Field Book 1
> J Field Book 2
> ) Field Book 3
> J Field Book 4
> J Field Book 5
> J Field Book 6
> ) Field Book 7
> J Field Book 8
> J Field Book 9
> ) Field Book 10
> ) Field Book 11
> ) Field Book 12
> J Field Book 13
> J Field Book 14
>
>
v
v

J Farmingdale Rd

CEsan 4 Pipes

3) Zoom in to examine the Linear Features, notice that some of them are not connected.
4) Under the Analyze Tab in the Decorations Tool Group select Names, Field Code, Elevations and Descriptions to
see these decorations. Select each again to turn them on and off in the display.

:J Survey v @~ Hl‘_' - - e X s SurveyPickup.dgn [3D
m Home Field Book Analyze Edit Terrain Geometry Drawing Production

Utilities View IDOT_Menu Help

Q r/ )‘ Ay Reset Details k 7, \ / u E E= {4l Names {8 Descriptions [ Icons \ o—o ?\
= {3 Field Codes [ Setups ) =t
Explorer Details Element ..., Report Redraw Media All VBA Aeasure Measure Measure
Selection i ¥ X Annotations Annotatio (M Elevations [ Observations Distance Radius Angle =5
Primary Selection View Annotations Decorations Measure

5) Using the Selection tool left click on the Linear Feature to access its properties.

e The Selection tool replaces several editing tools as it allows you to access the properties of the element
being edited. Because the survey information is contained as properties of the element a different mindset
is required as we now edit the graphical element which contains the information, instead of editing the data
in a separate file and reprocessing graphics.
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6) Notice that when you selected the Linear Feature text appeared at the points. These are referred to as Handles.

e |f you have the element selected but do not see the handles, zoom out slightly, they should appear. You can
also toggle off Decorations if the clutter your view.

e These handles offer a new way to edit elements. Hovering the cursor over the text Start and see it is the
Linking Code entered in the field. Hovering over Determined by Feature Definition indicates the Terrain
Attribute of the Linear Feature (whether it is included in the Terrain Model).

7) Left click on the text Start and notice the drop-down that appears.
8) Left click on the Down Arrow to expand the list and see the various Linking Codes that are available.

e Most should be self-explanatory; however, one commonly confused pair is CloseShape and Close. Close
simply connects the last point to the first. CloseShape will look at the first two points (and the resulting line)
then project a point to create a line that is perpendicular to the first.

e Other useful additions are the NonTanPC (Non-Tangent Point of Curve) and NonTanPT (Non-Tangent Point
of Tangency). These are very useful mapping out complex geometry such as curbs with access ramps. They
place Linear Features without forcing tangency to prior elements.

9) Select None from the list. Notice how the Linear Feature is removed.

e This is because without a Linking Code the software will not create the Linear Feature. Again, this may at
first seem to be backwards but if you realize the Linear Feature is based off attributes from the point, it
makes sense.

e This is just one example how instead of editing the “Line” you edit the properties of the point that made the
line. It also illustrates the point that the graphics are now directly linked to the survey data (if the data is
edited the graphics are now directly linked to the survey data (if the data is edited the graphics are updated
as well).

10) Click Undo to restore the Linear Feature.

e It may take a couple of times selecting Undo to restore the Linear Feature because of the underlying
processes involved. Take your time and allow the software to process each step in-turn.

e Asyou can see, Undo now works with survey operations. If you make a mistake there is no need to re-
import your data, simply undo the operation.

e Be aware Undo is only available during the current design session. If you close (or compress) the file, your
changes cannot be undone.

11) Edit the Field Code.
a. Hover over the Linear Feature again and notice the Field Code 672 — Edge of Street.
b. Left click on and hover your cursor over the linear feature again until the context menu appears. Select the

Edit Point Features tool.

0 My S Iy d"h Ay N v W &y -ilb‘l‘ %

Edit Point Features ...
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c. The Survey Details dialog opens, and all points from the currently selected linear feature are populated in
the dialog.
e You can toggle the display of the Survey Details dialog by selecting the icon from the Field Book, Analyze
or Edit menu tabs.

&4 Survey Details - *
(=) Blement List Iy Message Center
MName Display Field Code Link Code Zone Description Temain Mode! Attribute Aty
b e Troe |672 Start 1 | Deteine By Feature Definion
11193 True 672 NonTanPC 1 Netrming Av Fratire Nefinitinn
184 Troe 672 None 1 &1 survey A= T
| 11197 [True 672 | None L | Hom@Book Analyze Edit Te
11198 True 672 Norie 1 — - =
11202 Troe 672 NonTanPC 1 a 25 Reset Details k | Al
11203 True 672 End 1 :
< - - - Explorer Details Element .., Break
Selection i ~
Row: 1 of 7| b M
Primary Selection
d. Leftclick in the uppermost left-hand cell. This cell functions as a “select all” button.
&4 Survey Details = X

(=] Blement List 1 Message Center

‘ Name Display Field Code Link Code Zone Description Temain Model Atiribute i
» 11182 Determine By Feature Definttion
NonTanPC Detemmine By Feature Definition
None Determine By Feature Definition
MNone Determine By Feature Definition
None Detemmine By Feature Defintion
NonTanPC Determine By Feature Definition
End Determine By Feature Definition
< >
Row: 1 of 7| b Pl

III

e. Right-click in the cell below the “select all” cell to display the menu.
Steps F-G are for information only. THE FEATURE CODE IN THIS CASE SHOULD NOT BE CHANGED. We will
run into this later in Field Book 1.
f. Select Edit selected items in the menu. Then select Field Code from the second pop-up menu. A data entry
box pops up. Type in 678 then click the green check icon to enter your edits. (DO NOT CLICK THE GREEN
CHECK FOR THIS TRAINING).

©J Survey Details - X
[E] Bement List i\ Message Certer
Name
b liiie 2 :
Z*  Edit selected iterns. k| Mame 3 ~~— = P
Ol View k v | 2 Display » 4 Survey Details - *
A Selection v | Field Code » [E] Bement Lt i, Message Canter
wn  Export selected items... 3 Link Cod: L3
a : #g linkCade Narre Display Field Cade Lk Code Zsoe Descripbon Temain Mode! Arbute
A Create Control Points from selected items. M Tome 3
- " 2 Desci 3 ¥ L= i g Determine By Featurs Defintion
% Ec ations escription 3 Edit selected items, »
. : _ Ed #y Mam= . Determine By Feature Defintion
1@ M 7 TemainModel Aribute  » b 1 View v | # Display »
< - i et emine P Fa,
L2 &% Repon on selected items, S Atributes Pair b= A Selection » |2 Field Code 3
Riow| §
.X Delete 'Sc|l:.('tl:d items. s Control Codes » o Export selected items... » |2 Link Code » [ ™ ] |
T ResetDetails & Easting L3 A Creste Control Peints fram selected ibems. 2  Zone 3
& Morthing L = Edit Observations 2 Description * Del Pulpsis O
# Blevation C |©  Medifiles #  Temain Model Attribute Determine B Featue Deften
4 \‘M.Mscr\:l L £ Report on selected items, S Attributes Pair » 2
&/ Wedia File L ROW % Delete selected items. #  Control Codes »
T1| Reset Details & Easting 3
#  Northina »
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e The Survey Details dialog is one of your most useful to review and edit survey data. The far-left column
can be thought of as the selector field and common selection hot keys apply (holding Shift key to select
a range, Ctrl key to toggle individual rows).
e You can dock the dialog box at the top or bottom of your window or resize it and the fields within to suit
your needs.
e Itis worth noting that the fields displayed are a direct link to the information. If you change a value in a
field, you are editing the data. If you need to Undo an operation, give it a few seconds between clicks
(there will most likely be quite a bit going on behind the scenes).

g. Close the Survey Details dialog.

e Asstated before, by design the Linear Feature will inherit the Feature Definition from the points that
create it. Thus, if we edit the Field Code for the points, the Linear Feature changes as well (also, if we
change the Terrain Attribute, the Terrain Model will automatically update as well).

e Inthis section you saw how we use a different methodology for editing field data using Survey. While
different, as you become more comfortable, you will see it is more efficient as the graphics and terrain
model are dynamically updated. There are no additional steps to update the graphical elements to
match the data or rebuild the terrain model due to changes. This also reduces the chance for errors due
to the data and graphics falling out of sync.

h. Move to the area in the image below. Notice that our shoulder did not connect and if you zoom in there is a
gap in the points.

i. Zoom into the area and turn on Name on the Decorations tab so we can see the point numbers.

j. We are going to add Control Codes to Points 230297-230302 and then we will fix the shoulder starting at
Point 230303.

k. Zoom into the left side to Points 230297 and 11084.

I.  Using the Element Selector tool, place a window to select Point 230297 and open the Properties dialog if
not already open.

m. In the Properties dialog, locate Control Codes under the Point Feature section. Click on the 3 dots at the end
of the Control Codes line to open the Control Codes dialog box.
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n. Click the Add icon at the top and under Control Codes, there will be a drop-down menu. Select JoinPoint and
enter 11084 under Value. This is the name of the point you will join to point 230297.
0. Click on the pencil icon on the far left and then click Accept. Point 230297 should now be joined to point

& Properties - W
2 -
« EEESRaEN) Contral Codes

> HE 230267

Genera w

Geometry v

Point Feature F
230297
True
674
End
L Agributeray
Determane By Feature Definition Control Codes

g ) X
. .Qccept“:ld Delete
2402704 BT R A Gl
1155645 059" Control Codes | Value
575.344° oinFoirt 11084
L1Z5ILI7 e
B& Macro

L 12597 .

p. Repeat these steps to connect point 230298 to point 230302.

12) Left-click on the 674-Shoulder Feature Line and hover over it until the context menu pops up.

13) Select the Append Point in Linear Feature tool and left click on the next point, 11091. Left click again to accept
the edit. The shoulder line will extend to the next point.

14) Continue appending points to the Linear Feature by selecting the Linear Feature then the next point, as directed
by the pop-up prompts. Continue until all points are connected for the shoulder.

15) Notice the shoulder around the curve at the entrance is made up of lines rather than a smooth arc. We will now
fix this.

a. Select the Linear Feature Edge of Shoulder and hover on the line until the context menu appears.
b. Select Edit Point Features in the menu.
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c. The Survey Details dialog box opens. Locate Point 11200 and click twice in the Link Code column. Click on
the drop-down menu arrow that appears and select NonTanPC.
d. Locate Point 11190 and click twice in the Link Code column. In the drop-down menu select NonTanPT.

) foc M 46 ofdl b W

=) Bement Lt 1}, Massape Carter

Hame Display Fieid Code Link Code Zoce Descipton erain |
1201 Te 674
» M2 T 67
11189 T 674
1% T 67
11185 T 674
11190 Te 674

1189 T

CloseShape

e. Close the Survey Details dialog and notice that the shoulder is now a smooth curve.

16) Zoom to the intersection of IL 125 and IL 97, we are going to use another type of editing so you will have three
types in your toolbox.

17) Using the Element Selector, select Linear Feature 6741-Edge of Should. Hover over the line until the context
menu pops up and select the Convert to Point List Linear Feature tool. Repeat on each Linear Feature in the
vicinity that needs to be connected to another.

Convert to Point List Linear Feature

18) Select the Edge of Shoulder and hover over it until the context menu pops up and select the Join Linear Feature
tool. Select the Linear Feature to connect to, as prompted. The Edge of Shoulder line should now be connected
with no gap. By dropping the features to Point List you allowed the features to be joined. Continue to connect all
the Linear Features in the vicinity.
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19) When you have completed all the edits to Field Book IL 125/97, right click on the field book in Explorer and
select Create Terrain Model.
20) Left click on the Boundary of the newly created Terrain Model and hover over it until the context menu pops up
and select the Properties tool if it is not already open.
21) In the Properties dialog box, in the Feature section, left click on the drop-down menu arrow next to Feature
Definition and select TM_Ex_Boundary.

hems OpenRoads Model & Sheet Index =
v 4 A Terrain Model: IL 125/97
OpenRoads Standards Drainage and Utities Model
Survey > Xt Calculated Features
) &P, 4 # Source
ol o ot
i PR =
Genera v
Information v
Edge Method v
e e Calculated Features Display v
Create Adjustment
Create Terrain Madﬁk Source Features Display v
Export To =T -,
peiete Feature Dainiion SN Esting_Boundary
Import Feature Name | Termain ~
I e | ¥ Design
Properties Extended | Existing
b | Field Book 6 @ | st
Zoom Py Eosting_Boundan
b I F 7 E of
Isolate L 4 Existing Conk
> ] Fi % @ Bsting_( Ter E g\E
Clear Isolate @ Exsting_Contours and Triangles 200
. & 35 Deusils @ Exsting_Survey .
> | Ei @ BExsting_Thematic_Height
= Properties @ Eustng_Thematic_Slope
d I F @ Exstng_Triangles
5 | Fi @ Rock_Exsting_Boundary
@ PRock_Exsting_Contours
» | Field Book 13

@ Rock_Exsting_Triangles
@ Unsutable Boundary
Py zad

Continue to turn on and Edit Field Books
1) In Explorer, turn on Field Book 1 and Zoom in to the beginning of the job.

Note 1: All the concrete shots are linked together. We can delete the linear feature (the purple line).
Note 2: Notice the green circles near the beginning of the project. Left click on one and hover over it to see its
information.
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2) The green circles have a field code of 377-Well.
3) Select the White Line and hover over it to see its information.
4) The white line has a field code of 677-Center of Lanes, obviously, the field code is not coded correctly.

Terrain Model Attribute: SpotAndBreak
Data File Name: IL125-102016 asc. IL125-102016s6.asc
Field Book Name: Field Book 1
Feature Definition: Survey\IDOT_Survey\Pavement Features\677
Feature Description: Center of Lanes
il Creation Type: GeneratedByLinkCodes
Line String
Level: Topo_EOP

- Easting: 2426979.451
sl Morthing: 1147384.499"

Elevation: 546.466
Data File Name: IL125-102016.asc, 1L125-102016s6.asc
Field Book Name: Field Book 1 .
Feature Definition” Survey\IDOT_Survey\Drainage'377
Feature Description: Well
Cell: DRAIN_EX CATCH BASIN \ Circle
Level: Topo_Drainage ltems

5) In Explorer, navigate to Field Book 1 -> All Point Features.
6) Select Point 377. Under the Analyze tab, in the Primary toolset, select Details.

Explorer v 3 X Explorer v X
¥ em OpenRoads Madel &7 Sheet Index ¥ lems OpenRoads Model & Sheet Index
Dpentioads tandarie Dranage acd ks Madel OpenRoads Standards Drainage and Lkilities Mode!
Survey Survey
) @ \
el ol . QO@p.
5 [+] £
A2  rom—ry
L - = i £ Survey v @
4 B oN:Taneyiats o @' 352 Home Field Beok Ana

4 v [& Default

4 } Field Books

> v L1257 Elem
Selec

4 ] Field Book 1
= S

12 %> Data Files

Display the survey detail grid

v @405 Fenlnree

v @ 410

7) As an alternative to edit the points’ field codes, as outline previously in these exercises, work through the
following steps.
a. Inthe Survey Details dialog, select the column header Field Code to highlight the entire column.
b. Right-click on the Field Code header and select Edit.

4 Survey Details - 3
[E] Bement Ust i Message Center
Name Display Fdd Code e Lk Coce Zone Description Temain Mode ~
» 14241 True Erl None 1 Detemmine By
e e [ 5
7 Tres None &1 Survey Details - X
14252 True Hone (= Bement Lt | 1), Message Center
14257 True 377 None Hame Display FeldCode LinkCode Zone Desciption Temain Mode
14265 True m None o124 Te an :} Soit ““‘"""fg Detenine By
12269 Troe 377 Hone 14242 Troe A sor Descending Detemine By
< 14262 T Rename... Detemine By
Rew: 1 of8 | b bl 14257 True Show Columns v Detemine By
14265 e Freeze This Column Detemine By
14269 Te Alignment v Detenine By
14273 e Detsarine By v
< @ Find.. \ >
Row: 1 of8 | b M AL Replace...
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c. Inthe Edit Property Value box that pops up, change the Field Code from 377 to 677 and click OK.

Edit Property Value X
Field Code 677

d. Close the Survey Details dialog.
e. Notice the 377-Wells are now gone and the line is correctly displayed as Center of Lanes.

Linear Feature
Mame 2

Field Book Name: Field Book 1
Feature Definttion

Feature Description: Cer

: GeneratedByLinkCodes

Continue Editing Field Books

1) Zoom in to the area shown below. It is obvious that something is wrong here.
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2) Click on View Attributes in the upper left of your view window. At the bottom of the View Attributes dialog box,
select Aerial from the Background Map Type drop-down. Zoom in to the entrance in question. It is even more
obvious now that the shots at the entrance are wrong.

| w View 1 - Top, Defaull fo] View Attributes - View 1 - x
|||(_'L[‘I Ol 3t ~ L, viewhumbes 1% F

() Presentation

=
{[]
»

View Attributes
Display Style: | {Mdreframe Display)

by ACS Triad A FastCells
5 Background ’EF.\]

1] Boundary Display & G

i Camera &0 Level Overnides
E]Chp Back @L.ng Styles
G Clip Front [ ire vieights
C Clip Volume [ Markers
-Corstru.c:wor: F‘u1=rn5

] oetauit Lighing [ res

[ pimersiors (A7

Data Fields 14 TextNodes
58 Displayse: [ rrensparency

[Elromed Presentation  [§8] Heioht Field

Global Brightness: @

4 view Setup -~
Saved Views: |Select =
Models:

(2 Background Map »
Background Map Type: None w
Blevation Offset e
Transparency Eivhid

3) Next, we will edit these shots. (SHOTS SHOULD ONLY BE EDITED BY A LICENSED PROFESSIONAL SURVEYOR OR
UNDER HIS/HER DIRECTION).
4) We will start with the yellow line, which has a feature code of 607-Breakline.

5) Zoom in to Point 13442 and using the Element Selection tool, pick Point 13442. When the point number is
highlighted, left click on the point and drag it to the center of the entrance to match the other breakline shots.

e Repeat for points 674-Shoulder (13460), 657-Edge of Private Entrance (13436) and 647-Butt Joint(13438
&13439). Move each point to where it should have been shot in the field. The aerial mapping will aid in
correct placement.
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6) Turn off the aerial mapping background in View Attributes.
7) Finish editing the entrance by connecting all lines by selecting and moving points.
8) When all editing is completed, the entrance should look like the image below.

9) The next area of concern is the bike path that crosses the road.
10) Zoom in to the bridge along the bike path.
11) As you can see, the road needs to be connected in this area. Also, the bridge abutments need some editing.

12) Zoom in to the south abutment, select the abutment line and hover over it until the context menu pops up.
13) Select the Edit Point Features tool.
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14) In Survey Details dialog left click in the white box to the left of a point. Notice that the point highlights on your
screen. Each point you select will highlight.

15) Highlight the last point, 40891. In the Link Code column, change None to Close. Notice that the abutment is now
a closed shape. Repeat this action for the north abutment, 40256, and bridge deck, 40260.

|
() Bemert it 4 Message Corter
Nane Display Fkd Code Lk Code Zore Desciston Teman Mode 41
0884 T ) s 1 et By e
7 2 tene 1 7]
7% Hene ) Bomert st Mossage Cortr
Toe s None

[ Diaglay Fiskd Cade Lrk Code Zime Daserpion Terain Modsl A
24756 Here =

True 275
True 29756
28756

Do not worry about the fence shots going across the road as they are at the same elevation as the bridge deck.

16) Once you close all three shapes, right-click on Field Book 1 in Explorer and select Create Terrain Model.

MEY , . ame Terrain Model: Field Book
¥ tem | OpenFloadsModel & Sheet lndex —
Openfloads Standards | Ovainage and Uiiies Model - 11,204
Survey 3.054

0

ae.

Edge Methos

Create Terrain Made)

gg2ggegge|e822888 £ Eg"‘"

Expart To
L4 103
Delete
- 04
Import
- 134
i Brezklines
v a3
Boundary
v e imported Cortours
@ W s Islands
eSS Holes
v 26
Voids
- Feature Spols

e s Te—

sting_Boundary

I

@ Exsting_Contours
& Bsting_Contours | Terrain Existing|

@ Existing_Contours & = 1
@ Exsting_Survey I
ar. m . ou.

Be sure to change the Feature Definition of the Terrain boundary to TM_Ex_Boundary if it isn’t already labeled as such.

17) Left click on the Terrain boundary again and select Properties again. This time change the Feature Definition to

TM_Ex_Triangles.
Bowmdory on
Imported Contours ~ OF
iy o
Voids Off
Off

o — s
[T Estia Thordes |~
Tenain ~
B Desin
Existing
@ Existing_Boundary
P Existing_Contours

tours and Triangles
ours and Triangles 200

Survey
Exiting_Themaic_Heigtt
ing_Thematic_Siope

ck_Exsting_Bopndian:
Rock_Edsting_Cel_ Terrain\ Existing\ Existing_
Bt Bt T B |

TTLLLLILLY
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18) Right-click in a blank area in your drawing display and select View Control -> 2 Views Plan/3D.

View Control

5 Copy
g

@ 2 Views Plan/iS
@ 2 Views Plan/Profile
2 Views Plan/Superelevation
3 Views Plan/Superelevaticn/XS
3 Views Plan/Profile/3D
3 Views Plan/Profile/Xs
3 Views Plan/(5/30
4 Views Plan/Profile/X5/30
Ref Adjust Colors
Diynamic X5 View
Cut to Clipboard Werdi=s

[y Copyte Clipboard Teggle Construction Class

| Pastefrom Clipboarg = bevels Off Except Bement

Move
5 Scale

B8 Displayset Set

() Select All
Sedect None
Select Previous

EE({feeeeew

Delete Element B8 Displayset et
- Displayset Clear
B Propetie: Armrange Windows

19) In View 2, left click on the View Attributes drop-down and under Presentation, click on the Display Style drop-
down and select Smooth.

20) Zoom in to the bridge area in View 2. Rotate the view to get a good view of the bridge’s profile. As you can see,
there are some problems in the terrain at the bridge.

= Top, Default

=B\ - L PLPROAD HaB:

icw b 2 - |2 OF

(D) Presentation m=a
Displey Style: |5 Mustrationignore Lighing F
o ACS Trind ) lustration-lgnore Lighting Y

i lilustration Modeling
ad Bachgroun{ - ) liustration Shadows
J\L Boundary [ llustration Sky Sphere
& Camera | Manachrome .
e %! Monochrome Modeling
* 5 Monochrome: Shadows
< Clip Front |4, Monachrome:Sky Sphere
ﬂmip\rm_ -
) Smacth:Modeling

.L‘onsnum o

Defsuit Lisl ) smaceh Sky Sphere
iD!mmslom ) Smooth: SkyBox »

H Niata Eimlie A Taet Mrcins

21) Left click on the bridge deck and hover until the context menu pops up. Select the Edit Point Features tool.
Note: It is easier to left click on the bridge and fence in the Plan View (View 1).

Edit Point Features ...

22) Expand the Survey Details dialog box to see the column labeled Terrain Model Attributes. Select the column and
right-click on it.

23) Select Edit, and in the Edit Property Value box that pops up, select Do Not Include from the Terrain Model
Attribute drop-down then click OK. Close the Survey Details dialog box.

£ Survey Details - »

= Bement List 8 Message Center

4] SertAscending
%] Sort Descending
Custom Sarting...

Rename...
Show Columns 3
Freaze This Calumn

Alignmant

'R Find..

AL Replace..

0K Cancel
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24) Do the same to the fence lines that cross the road. This will clean up the area below the bridge for a cleaner

terrain model.

Chapter 2 Review

General Information

» The Terrain “Model”

o Must be built in a 3D design file along with ALL Survey data. 2D files are not needed from Survey for

Design.
A physical model, NOT a MicroStation model
New Design element (replaces DTM, TIN, etc.)
Created by Survey (or from existing files)
Holds all known data for the existing terrain model
Allows for different display styles (Triangles, Contours, Thematic) in a single package.

O O O O O

New Concepts

» Creating a new WorkSet for each Design file.

» Geographic Coordinate System
o Take time to verify it is set in each design file throughout the project

> All Survey data is contained within the Design file.
o No external files to synchronize graphics data with.
o The graphic elements in the Design file are “intelligent” and “know” certain Survey properties.
o All edits are done in the Design file.

» Dragand Drop Import Process

Skills Checklist
» Create new WorkSet
» Context Sensitive Toolbar:
o Making it appear
o Utilizing the commands
» Understanding / using:
o Feature Definitions
o Project Explorer
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EXERCISES - Chapter 3 - Using and Editing Terrain Models

E3.1 - Terrain Model Review and Display

If you have already worked through the Chapter 2 Exercises you can skip the Design File Setup

steps 2 through 6 below.

Design File Setup - Outside ProjectWise
1) Start OpenRoads Designer
2) Setthe Workspace and Work Set

e The Workspace and Work Set define standards that are used by the software. The Workspaces are set up

during the software installation. In this training we will be using the District WorkSpace, but this could

change depending on software and Workspace Standards updates.

e The following steps will set up the Workset you will be using throughout this training. Internally within IDOT

your CADD Manager will take care of setting up the Workset for the project and everyone’s use.

3) Select District from the WorkSpace pulldown menu then select Create Workset from the WorkSet pulldown

menu.

WorkSpace WorkSet WorkSpace ~ WorkSet

No WorkSpace * No WorkSet District ~ _Template for New WorkSet ~

o] [e]
I L Recent Fil £
Custom Configuration = _Template for New WorkSet
. is¢ You haven't ¢ tz

Aerial Surveys

Bridge

District «

IDOT Consultant B

rowse
Winaie Talhane >
No WorkSpace

== Create WorkSpace

f? ) ; ;
:“ Configuration Assistant

1% pWG Workset Wizard
e — » == Create WorkSet...

4) The Create Workset Dialog Box will open, fill in and select the following:
e Name: D69621
e Description: IL97/125 Reconstruction

e From the Template dropdown selection box select: _Template for New WorkSet and click OK to continue.

Create WorkSet X

Name: = D69621

Description:  IL 97/125 Reconstruction

Template: [ Template for New Workset = Create Folders Only

= Add a Custom Property ~

Folder locations

Root Folder:
Design Files:
Standard Files:

Standards Subfolders:

ProjectWise Projects

Browse...

OK Cancel
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5) On the right side of the screen, you will see “Properties” select it and then select “Advanced Properties”. Fill in
the Advanced Properties in the Edit WorkSet dialog with the following:

e Contract No.: C94598

e County: Sangamon Name:

° FAP Type P. Description: L 97/125 Reconstruction
Contract No.  C94598

e Route: 1L97/125 Couty [Semgmer

o Scale: 1”=50’ FAP Type  P.

e Section: (52X63) ":“‘I* :”ZO‘”

e SHEETTITLELINE1:1L97/125 Section | 52463

e SHEETTITLELINE2: Plan Sheets SHEETTITLELINE | IL97/125

SHEETTITLELINE2 Plan Sheets

Structure No.  S.N.

= Add a Custom Property ~

6) Click OK to save and exit the Edit WorkSet dialog box (not shown). These Properties will automatically fill in the
Title Block on all sheets in this project. This is the current workflow, this will be changing with future releases of
the software and IDOTCAD Environment, training will be provided at that time.

7) Select New File. Navigate to the location where you unzipped the data set files. Name the new file
d2275TerrainModel.dgn. Click Browse and select the IDOTeng3d.dgn Seed file and click Save to close the dialog
box and open the newly created file.

Design File Setup - Inside ProjectWise

Specific instructions will be presented during class on how to utilize the Managed Workspace within
ProjectWise. Your CADD Manager will also have more information if needed as well as be setting up the
WorkSet folders for the entire Project.
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Set the Geographic Coordinate System

Before we import the Survey data, we need to ensure the Geographic Coordinate System (GCS) is set correctly.
This enables the software to make automatic adjustments so data from different systems will mesh seamlessly.
Surveyors more than anyone can appreciate the importance of setting the correct Geographic System.

1) Select the Survey Workflow from the drop-down menu. Survey | &
2) Under the Utilities tab, in the Geographic toolset, select the Coordinate CpenioacsModelng
Fro Y OpenRoads Drawing Production
System tool. N ST
{; " . Geotechnical
3) Select From Library icon. - C'I'Sgr;'f'cg:_zte Reality Modeling
4) In the Library Dialog click the Search tab and type lllinois in the “Search Drawing
Text” and hit Enter. el
Visualization

Drainage and Utilities

% Select Geographic Coordinate System

Library Search
Search Text ‘Ilhnois\ | [ FindNew ]
(® Any \word O All \words
Key Name Description Units Projection EPSG Code Datum Elipsoid
it
< >
Cancel

5) Click on the Units column header to sort by it.
6) Select all the “Key Name” Coordinate Systems with units of “US Survey Foot” (Shift pick the top and bottom one)

% Select Geographic Coordinate System

Library  Search

Search Text ‘Ilhnols

(® Any Word O All Words
Key Name Description Units/\ Projection EPSG Code Datum Hiipsoid
ILHP-E Use HARN/IL.IL-E instead - HARN lli... METER ~ TM 2750 HPGN GRS51980
NSRSO7.IL-W NSRS 2007 llincis State Plane, West METER TM 3530 NSRSO7 GRS51380
NSRSO07.IL-E NSRS 2007 linois State Plane, East .. METER M 3528 NSRS07 GRS1380
IL83-wW NADS3 llinois State Plane, West Zon METER TM 26572 NADS3 GRS1580
IL83E NADS3 llincis State Plane, East Zone... METER ~ TM 26971 NADE3 GRS1380
1L83/2011-W NSRS11(NADE3/2011) lincis, West .. METER  TM 6456 NADB3/2011  GRS1980
1LB3/2011-E NSRS11{NAD83/2011) linois, East METER TM 6454 NADB3/2011 GRS1580
EPSG:102271 NAD 1383 HARN StatePlane llincis ... Meter ™ 102271 HPGN GRS1380
NADB3{HARN) / llinois East ftUS) US Sur. ™ 3443 HPGN GRS51380
NADB3HARN) / llinois West ftUS) uUssur.. TM 3444 HPGN GRS1380
NADS3 / llincis East ftUS) usSur.. TM 3435 NADE3 GRS1380
NADS3 / linois West ftUS) US Sur. ™ 3436 NADS3 GRS1580
NAD 1383 StatePlane llinois West FI..  USSur..  TM 102672 NADE3 GRS1380
NAD27 / lincis East US Sur. ™ 26771 NAD27 CLRKEE
NAD 1383 StatePlane llinois East FIP... USSur.. TM 102671 NADB3 GRS1380
NAD27 / llincis West usSur.. TM 26772 NAD27 CLRKEE
>
Add To Favorites
0K Cancel

7) Select Add to Favorites button at the bottom to add your selection.
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8) Select the Library tab at the top of the Dialog.
9) If “Favorites” is not expanded, click the plus (+) sign next to it to expand. This will show you the coordinate
systems that you picked that apply only to lllinois.
e Also notice that there is an IDOT and IDOT_2021 folder listed with the Favorites folder. The IDOT folder lists
the original District 8 LDP zones per county. The IDOT_2021 folder lists the 33 new LDP zones.

% Select Geographic Coordinate System

Lbray  Search
B0 Favortes Coordinate System an
{5} EPSG:26771 - NAD27 / linis Ezst
G e
5G:26772 - NAD2 / lincis West NAD 1583 StatePlane linots |
'5G:102671 - NAD 1983 StatePlane llinois East FIPS 1201 Fest Transverse Mercator
5G:3424 - NADB3HARN) / lincis West ftLS) L
5G:3443 - NADS3{HARN) / llinois Ezst ftUS) ESRI PRJ [ArcGIS]
5G:3436 - NADS3 / llinois West tUS) US Survey Foat
5G:3435 - NADS3 / llinois East tUS) SUTIGOC-H000°W
ot 36°40°00.0000°N
o
Lbrary e
Positive X and Y
52°15'00.0000"W
87°45'00.0000"W
36°00°00.0000"N
43°00°00.0000"N
-
NADS3
North American Datum of 1987
US Defense Mapping Agency.
NADS3 - no shift roquired
v
G

10) Double Click on EPSG:102672-NAD 1983 StatePlane lllinois West FIPS 1202 Feet under your Favorites.
11) Close the Geographic Coordinate System Dialog.

Create the Terrain from a “.dat” File

1) Select the Survey Workflow from the drop-down menu if it is not already selected

2) Under the Terrain tab, in the Create toolset, select From File. Navigate to the location where your project is
saved and select the d2275compositea.dat file from the Chapter 3 folder and click Done.

2l [survey A=l - | 7
[l openroads Modeling Anahoe  Edit
OpenRoads Drawing Production |suwey MIEEN=] = | =Sk X s
2 Survey it
B T, k - m Home Field Book Analyze Edit Terrain Geometry Drav
Reality Modeling & 0.0 ,_% 4
Drawing = = hical Fil g B 3
: B v 2| From Graphical Filter ~ 5 () ]
Modeling Element i Additional  Topo (‘) Active
Visualization — B Selection L.} ¥ & Iirom Elements Methods ~  Import ¥ | ¥ v
Drainage and Utilities . . "2 seect Fies To lmport - ChUsers) \DeskropLesmneie neFiles y —
CRE b AR PPt S Primary Selection e — ST an

d F
: p roi # Mame Date modified Tpe
Imp| . Completed Files 10/1/2020 1218 PM File fokder
[ wick access Videos W0/120001219PM il foldes
u View 1-Top, Default ¥l d275compasien dat SI4/2011 248 PM DATFile

d2275compasitentin 48PN TN File

Deskiop D227SE16Composite.dat 5/9/2016 12:53 PM DAT File
D2275E16Composite in S/8/2016 1253 PM TIN File k

n
Librasies

3) Inthe Import Terrain Model(s) dialog box set the following:

5 X [a) -
e

Under File Options: .
e Feature Definition: Terrain\Existing\ TM_Ex_Boundary
e Edge Method: Max Triangle Length
e Maximum Side Length: 100.00 = .
e Input Options: Both S
e Include Spot Features: Check On
¢ Name all Features: Check On .
e Geographical Coordinate Systems: ESPG: 102672
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4) Click Import. This may take some time to load all the points, breaklines, etc.
5) Click on Fit View to see the imported data.

6) Once the first Terrain Model is imported, close the Import Terrain Model(s) dialog, and select From File again.
Then select the D2275E16Composite.dat file. In the Import Terrain Model(s) dialog, use the same settings as
before, except this time check the Append to existing Terrain Model box.

:J Import Terrain Model(s)

Global Options

X -AJ Terrain Models

-~
¥ D2275E 16Compasite

Append to existing Terrain Model \;/E;
Terrain Model to append to a2%] ompositea

Projection

Target None
7) Fit the view to see the whole Terrain Model and the Appended portion.

8) Using the Element Selection tool, select the Terrain Model Boundary and hover until the context menu pops up,
then select Set as Active Terrain Model.
[ )

Setting the terrain model active automatically creates a 3D model and attaches it to the 2D design file as a
reference.
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9) Right-click and hold in View 1. Select View Control -> 2 Views Plan/3D to open the 2D and 3D views side by side.

View Control

Copy
i Move
-1 Scale
&h, Rotate

sih Mirror

¥ Select Links

I il AEE

10) Fit both views.

1 View

(@ | 2 Views Plan/3D

[§ 2Views Plan/%s

(g 2Views Plan/Profile

|

[d 2 Views Plan/Superelevation

[d 3 Views Plan/Superelevation/X5
[# 3 Views Plan/Profile/3D

[@ 3Views Plan/Profile/ X5

W Le

A

Create Terrain from “.tin” files

1) Select File at the top left and create a new 3D file and name it d2275 Terrain from tin.dgn.

2) Click Save and the newly created .dgn will open.

Open

Element P
o Selectiy ,7L...: =
Primary Selection
o

Browss

W View 1 - Top, Default

Recent Files for C

£ New - C:Jamie Test Project (IL 97)\Using and Editing Terrain Models\ X
Savein: [ || Using and Ediing Terain Models v @@ @ Hm
Name ’ Date modified Type Size
Completed Files 12/16/2021 1057AM  Fie folder
Qs Videos 12/16/20211058AM  File folder
Desktop
Libraries
d2275T ™
CJamie LasaLD8387
Network
Fie name: 42275 Teman rom il <] save |
Saveastype: | MorStation DGN Fies (“dgn) v Cancel
et [CD0TCAD GROG DO | [ o

3) Follow the previous steps to set the Geographic Coordinate System in your new file.
4) Under the Terrain tab, in the Create toolset, select From File. Navigate to your working folder and select the file

d2275compositea.tin then click Done.

g Survey

N Y

Element ...
1] Selection L1 7
Primary Selection

Field Book

& Frar File |
= FII'_::khIL'e Filter =

Bl Wiew 1 = Tron Mefaat

A=l -]

Analyze Edit

= k X =

Geometry

@

A

Additiana Topo
q From Elements Methods >  Impoet
Create
Fram File ature Defindion

mpart Terramn Madel Fram File

5) The Import Terrain Model(s) dialog box will open.
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6) Use the same settings as the first import in the previous exercise and click Import.

o Feature Definition: Terrain\Existing\ TM_Ex_Boundary
e Input Options: Both

e Include Spot Features: Check On

o Name all Features: Check On

e Geographical Coordinate Systems: ESPG: 102672

7) Once the first Terrain Model is imported, close the Import Terrain Model(s) dialog, and select From File again.
Then select the D2275E16Composite.tin file. In the Import Terrain Model(s) dialog, use the same settings as

before, except this time check the Append to existing Terrain Model box.

8) Select Fit View to see the complete Terrain Model.

Create a New .dgn

9) Select File at the top left and then New.

<l

Sumnvey
7

i Home Fin

Ope

F‘rlnmr:.' Rece

10) Name the file d2275 Combined Composite.dgn and make sure you select the proper 3D Seed file and click Save.

&4 New - C:\Jamie Test Project (IL 97)\Using and Editing Terrain Models\

Savein: | | | Using and Edting Temain Models ’@F @
* Name ~ Date modified Tpe Size
Completed Files 12/16/202110:57AM  File folder
Guickiaccess Videos 12/16/202110:58AM  File folder
‘z £4d2275 Terrain from tin.dgn 1/11/2022 1:06 PM Bentley MicroStati... 15,976 KB
Desktop
(]
Libraries
L434LD8387
‘\'15

Network

File name: 42275 Combined Composite

[ save

Saveastype: | MicroStation DGN Fes ("dgn)
Seed C:IDOTCAD_ORD\Configuration\Organization Civi\IDOT_Standards\Seed\IDOTeng3D.dgn

Cancel

Browse
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11) In the upper left corner, select the Survey Workflow from the drop-down, if it is not already selected.
12) Under the Home Tab, in the Primary Toolset, select Attach Tools -> References.
13) Attach the files d2275composite.dgn and D2275E16Composite.dgn. Both files can be found in the Chapter 3
folder. These files are topo delivered from Aerial Surveys.

14) How would you fix the Annotation errors that are presented after referencing the files together?

E3.2 - Complex Terrain Models
When multiple terrain models need to be combined, the recommended best practice is to reference the terrain

models into a blank file and create the new complex terrain model there. This keeps the complex and the source terrain
models organized in separate files making it easier to manage your data.

1) Continue in the d2275 Combined Composite.dgn file to create a combined Aerial Survey terrain model.

2) Under the Terrain tab, in the Create toolset, select Additional Methods -> Create Complex Terrain Model tool.

ERPPODW D

3) Select the d2275compositea and D2275E16Composite terrain models in the left-hand pane of the Create
Complex Terrain Model dialog and click Add. You will Append the D2275E16Composite to the d2275compositea

terrain.
-
;‘J Create Complex Terrain Model el - | X
Select Temain Models
Select Terrain Models to Merge or Append o Append
d2275composies | PN Process Order Name Process Order Name Merge/Append
< Remove 2 D12275E16Composite Append
Current Action Cument Action
() Merge () Merge T
® Append ®) Append
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4) Set the Feature Definition to Terrain\Existing\TM_Ex_Triangles and name the new terrain Aerial Survey and
click Finish to append the two terrain models into one Aerial Survey terrain model.

Temain Model Properties

Terrain Feature Definition ~
Festure Definition |Tarrain'-.Etis‘ting'-TI‘\"I_Ex_TriangIes ~ |
Hame |Aeria| Survey |

Cancel Finish

Add the Pickup Surveys to the Complex Terrain Model

5) At the top left, select File -> Browse and navigate to the Chapter 3 folder of your data set and open the blank 3D
design file named Complex Terrain Model.dgn.

6) Once the file opens go to the Home tab on the Survey Workflow. In the Primary toolset, select Attach Tools ->
References.

7) From the Chapter 3 folder in your data set attach files Pickup Survey.dgn and D2275 Combined Composite.dgn
using the Coincident World attachment method.
Note: All Field Books must be checked in Explorer in the PickupSurvey.dgn file for all the terrains to show up

when referenced into this file.

8) Select the file D2275 Combined Composite.dgn in the References dialog and Turn On Live Nesting to a Nesting
Depth of 1 and then close the References dialog.
9) Fit the view to see the entire project.
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10) Under the Terrain tab, in the Create toolset, select Additional Methods -> Create Complex Terrain Model tool.
11) Select the Aerial Survey terrain model in the left-hand pane and click Add. The Aerial Survey terrain model is
added as the Primary terrain model.

12) Set the Current Action to Merge. The data from the primary terrain model is discarded and replaced with the

data from the merge terrain model in the area where the two overlap. The two terrain models must overlap
with at least one point.

13) Select all the other terrain models in the left-hand pane and click Add.

14) Set the Feature Definition to Terrain\Existing\TM_Ex_Triangles and the Name to Existing Ground Survey.
15) Click Finish and a new terrain model named Existing Ground Survey is created.

£ Create Complex Terrain Model - O X
Select Temain Models
Select Terrain Models to Merge or Append
~
FIOCES Name Merge /Append
Cument Action 2 d2275compositea Merge ~
7! “
@ Merge 3 D2275E16Composte | Merge T
N 4 Farmingdale Road Merge ~
O Append
5 Field Book 1 Merge ~ \L
6 Field Book 10 Merge ~
7 Field Book 11 Merge ~
8 Field Book 12 Merge ~
9 Field Book 13 Merge ~
10 Field Book 14 Merge ~
11 Field Book 2 Merge ~
12 Field Book 3 Merge ~
v
Temzin Model Properties
Terrain Feature Definition ~
Feature Definition isting . TM_Ex_Triangles ~
Name Existing Ground Survey|
From Selection Set > Cancel Finish

16) Open the Attach References dialog and turn Off the two reference displays. Do not detach the references, just
turn the display off.
The result is the single new complex terrain model. The model is currently displaying the triangles based on the
assigned feature definition TM_Ex_Triangles, but that display can be changed by changing the feature definition.
Note: The Edge Method set in the primary terrain model is applied to the combined terrain model. If your results

differ from the image below, you can go back to the d2275 Combined Composite.dgn file and review what edge method
was last applied to the Aerial Survey terrain model.

Terrain Model: Existing Ground Survey
Level: TM_Ex (Terrain Model - Existing Ground Terrain)
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Merge and Append Options

Terrain models can be combined into Complex Terrain models. The complex terrain model is not only a
combination of terrain models but a combination that remembers the order in which terrain models are combined and
how they are combined. Terrain models can be combined by merging or appending them together.

e Merge — The data from the primary terrain model o fareain T |+ . -
is discarded and replaced with the data from the M°‘?L;i€i’:<i’r:; . + N Py Tl
merged terrain model in the area where the two i Green =
. . M Terrain Model
overlap. The two terrain models must overlap with SR,
. Complex using + + + +
at least one point. Merge Action +
& + + 4+ +
e Append — The combined data from both terrain
. . . . Complex using + ++ + +
models is retained in the areas where the terrain Append Action +
. + R + +
models overlap. The two terrain models can

overlap or be adjacent to one another.

When the terrain models are combined, the Edge Method of the primary terrain model is applied to the new
combined terrain model.

Note: The Edit Complex Terrain Model tool is used to make changes to complex terrain models such as changing
the order of the terrain models or the merge/append action. You can also add additional surveys to it later as needed.
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E3.3 - Add a Boundary and Modi

In this section, you will learn how to add a boundary to the terrain model and then modify the boundary feature.
The Add Boundary tool extracts the implied or stored boundary from a terrain and adds it to the terrain as the edge
method, overriding all other edge methods. The tool options provide the ability to create a 3D graphic of the boundary,
add a non-graphical feature to the terrain or add an editable graphical boundary that is ruled to the terrain.
1) Continue in the Complex Terrain Model.dgn file.
2) Under the Terrain tab, in the Edit toolset, select Boundary Options -> Add Boundary and set the following
parameters in the dialog box:
a. Method: Add Ruled Boundary
b. Feature Definition: Linear > Terrain_Feature > TM_Exterior
c. Name: Boundary
3) Atthe Locate a Terrain Model prompt, click the Terrain Model to identify it and then click through the options
on your cursor that you set in the dialog to accept them and process the command.

What happened?
e The boundary was added to the model as an editable boundary that is ruled to the terrain.
e The edge method was set to From Boundary.
e The terrain model was processed (triangulated)

a. Select the edge of the terrain to highlight the new boundary graphic and hover over it.

e The line string is on level TM_Pr_Exterior (from the feature definition setting)
e The context sensitive toolbar is available.
e Handles are available on the line string for modifications.

Note: After a boundary has been added to a terrain model, the Terrain > Edit Model tools cannot be used to edit

the model.

]

Line String
Level: TM_Pr_Exterior (Terrain Model - Proposed DTM Exterior Boundary)

\‘\--..

4) Zoom out/in to move your view to the Northwest corner of the complexed terrain model. The boundary graphic
may or may not be selected.

5) Under the Drawing tab, in the Modify toolset, select Insert Vertex. Click on the boundary graphic, then move
the cursor and click to identify the location for the new vertex. The boundary graphic and triangles are updated
to reflect the change in the boundary.
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6) Repeat the process in the Southeast corner of the complexed terrain model.

Terrai Moel Existing Ground Suey
Triangles
Elevation 590.36%

Slope 1.75 &
Aspect 198.88 h
W Level: TM_Ex (Terrain Model - Existing Ground Terrain) g

8) Select the border element to highlight the boundary graphic so that the handles are visible.

9) Under the Drawing tab, in the Modify toolset, select Modify Element. Select the Border Element near the upper
handle and move the vertex to the new location at the intersection as shown.

Line Strin
Level: TM

10) Continue to move around the model boundary and use the Modify tools — Modify Element, Insert Vertex and
Delete Vertex — to modify the boundary graphic to remove undesired edge triangles.

Note: A boundary feature added to a terrain model will control the creation of triangles regardless of future
feature edits or reprocessing of the terrain model.
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Add Boundary Methods
e Extract Graphic — Creates a graphical 3D line string that can be edited. It is just a simple graphic and is not linked

to the terrain in any way.

e Add Boundary — Extracts the current boundary for the triangulation and creates a non-graphical boundary

feature within the terrain model and it overrules all other trimming methods (Sliver, Max Edge Length).

e Add Ruled Boundary — Extracts the current boundary for the triangulation and creates an editable graphical

boundary that is ruled to the terrain. It overrules all other trimming methods (Sliver, Max Edge Length).

Chapter 3 Review

General Information

» Terrain models:

O

Contains the information known about the surface and uses feature definitions to display that
information to the user (triangles, contours, or a simple boarder.)

Most often a terrain model is referenced into another design file and the Override Symbology option
can be enabled to allow control of their display.

The thematic height display provides a color shaded display based on elevation, aspect angle (direction),
slope and hill shade.

» There are many methods available to create terrain models.

> After a terrain model is initially created, there may be a need to make additions and revisions to it. If it is

created correctly, it will automatically update as the base information is updated.

Skills Checklist

> Be able to create a terrain model directly from graphical elements and from graphical filters and filter

groups.

> Be able to modify a terrain model

o O O O

e}

Add features

Change feature type

Correct crossing break lines

Resolve conflicting points

Control, add and delete triangles using the Edit Model tools

> Be able to create a complex terrain model from two terrain models

O

O

Append and merge
Add boundary feature
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EXERCISES - Chapter 4 - ROW, Parcels and Plats

The objective of this chapter is to teach tools and techniques that can be used for developing Right of Way Plans
on roadway projects. In this chapter you will learn how to establish the existing right of way centerline, how to create
the existing right of way lines and how to create an existing property parcel from record data. You will also learn how to
create proposed right of way lines, a proposed parcel, and legal description. And lastly, you learn how to create right of
way plan sheets and annotation.

ST
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1ma \ Files: A
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E4.1 - File Setup, Understanding the Interface, and Extracting Parcels
In this exercise, you will learn how to Create a Parcel with Geometry builder. The included Parcels are based on a

calculated parcel from PowerGEOPAK SS10.

If you have already worked through the Chapter 2and 3 Exercises you can skip the Design File
Setup steps 2 through 6 below.

Design File Setup - Outside ProjectWise

1) Start OpenRoads Designer
2) Setthe Workspace and Work Set

e The Workspace and Work Set define standards that are used by the software. The Workspaces are set up

during the software installation. In this training we will be using the District WorkSpace, but this could

change depending on software and Workspace Standards updates.

o The following steps will set up the Workset you will be using throughout this training. Internally within IDOT

your CADD Manager will take care of setting up the Workset for the project and everyone’s use.

3) Select District from the WorkSpace pulldown menu then select Create Workset from the WorkSet pulldown

menu.

WorkSpace WorkSet
No WorkSpace ~ No WorkSet

| 2l

Aerial Surveys

Bridge

District «

IDOT Consultant

WhinAie Tallivae s

== Create WorkSpace
L
ct Configuration Assistant

1> pwG Workset Wizard

i5€

WorkSpace ~ WorkSet
District ~ _Template for New WorkSet ~

§el
Recent Fil

_Template for New WorkSet

You haven't ¢ ta

Browse

4) The Create Workset Dialog Box will open, fill in and select the following:

e Name: D69621

e Description: IL97/125 Reconstruction

e From the Template dropdown selection box select: _Template for New WorkSet and click OK to continue.

Create WorkSet X

Name:
Description:

Template:

D69621

IL 97/125 Reconstruction

_Template for New WorkSet

Create Folders Only

== Add a Custom Property ~

Folder locations

Root Folder:
Design Files:
Standard Files:

Standards Subfolders:

ProjectWise Projects

Browse...

OK Cancel
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5) On the right side of the screen, you will see “Properties” select it and then select “Advanced Properties”. Fill in
the Advanced Properties in the Edit WorkSet dialog with the following:

Edit WorkSet X

Contract No.: C94598

County: Sangamon

FAP Type: P.

Route: IL97/125

Scale: 1”=50’

Section: (52X63)
SHEETTITLELINE1: IL97/125
SHEETTITLELINE2: Plan Sheets

Name:

Description:

IL 97/125 Reconstruction

Contract No.
County

FAP Type

Route

Scale

Section
SHEETTITLELINE1
SHEETTITLELINE2

Structure No.

94598
Sangamon
P.
IL97/125
1"=50"
(52X63)
IL97/125
Plan Sheets

SN.

= Add a Custom Property ~

6) Click OK to save and exit the Edit WorkSet dialog box (not shown). These Properties will automatically fill in the
Title Block on all sheets in this project. This is the current workflow, this will be changing with future releases of
the software and IDOTCAD Environment, training will be provided at that time.

7) Select Browse and navigate to the location where you unzipped the dataset files. Select the file IL97_125

Parcels.dgn from the Chapter 4 folder and click Open.

Design File Setup - Inside ProjectWise

Specific instructions will be presented during class on how to utilize the Managed Workspace within

ProjectWise. Your CADD Manager will also have more information if needed as well as be setting up the

WorkSet folders for the entire Project.
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Set the Geographic Coordinate System

Before we import the Survey data, we need to ensure the Geographic Coordinate System (GCS) is set correctly.
This enables the software to make automatic adjustments so data from different systems will mesh seamlessly.
Surveyors more than anyone can appreciate the importance of setting the correct Geographic System.

1) Select the Survey Workflow from the drop-down menu. Survey | &
2) Under the Utilities tab, in the Geographic toolset, select the Coordinate CpenioacsModelng

Fro Y OpenRoads Drawing Production

System tool. N ST
{; X . Geotechnical
3) Select From Library icon. "« C'I'Sgr;'f'cg:_zte Reality Modeling
4) In the Library Dialog click the Search tab and type lllinois in the “Search Drawing
Modeling

Text” and hit Enter.

Visualization

Drainage and Utilities

% Select Geographic Coordinate System

Library Search
Search Text ‘Ilhnois\ | [ FindNew ]
(® Any \word O All \words
Key Name Description Units Projection EPSG Code Datum Elipsoid
it
< >
Cancel

5) Click on the Units column header to sort by it.
6) Select all the “Key Name” Coordinate Systems with units of “US Survey Foot” (Shift pick the top and bottom one)

% Select Geographic Coordinate System

Library  Search

Search Text ‘Ilhnols

(® Any Word O All Words
Key Name Description Units/\ Projection EPSG Code Datum Hiipsoid
ILHP-E Use HARN/IL.IL-E instead - HARN lli... METER ~ TM 2750 HPGN GRS51980
NSRSO7.IL-W NSRS 2007 llincis State Plane, West METER TM 3530 NSRSO7 GRS51380
NSRSO07.IL-E NSRS 2007 linois State Plane, East .. METER M 3528 NSRS07 GRS1380
IL83-wW NADS3 llinois State Plane, West Zon METER TM 26572 NADS3 GRS1580
IL83E NADS3 llincis State Plane, East Zone... METER ~ TM 26971 NADE3 GRS1380
1L83/2011-W NSRS11(NADE3/2011) lincis, West .. METER  TM 6456 NADB3/2011  GRS1980
1LB3/2011-E NSRS11{NAD83/2011) linois, East METER TM 6454 NADB3/2011 GRS1580
EPSG:102271 NAD 1383 HARN StatePlane llincis ... Meter ™ 102271 HPGN GRS1380
NADB3{HARN) / llinois East ftUS) US Sur. ™ 3443 HPGN GRS51380
NADB3HARN) / llinois West ftUS) uUssur.. TM 3444 HPGN GRS1380
NADS3 / llincis East ftUS) usSur.. TM 3435 NADE3 GRS1380
NADS3 / linois West ftUS) US Sur. ™ 3436 NADS3 GRS1580
NAD 1383 StatePlane llinois West FI..  USSur..  TM 102672 NADE3 GRS1380
NAD27 / lincis East US Sur. ™ 26771 NAD27 CLRKEE
NAD 1383 StatePlane llinois East FIP... USSur.. TM 102671 NADB3 GRS1380
NAD27 / llincis West usSur.. TM 26772 NAD27 CLRKEE
>
Add To Favorites
0K Cancel

7) Select Add to Favorites button at the bottom to add your selection.
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8) Select the Library tab at the top of the Dialog.
9) If “Favorites” is not expanded, click the plus (+) sign next to it to expand. This will show you the coordinate
systems that you picked that apply only to lllinois.
e Also notice that there is an IDOT and IDOT_2021 folder listed with the Favorites folder. The IDOT folder lists
the original District 8 LDP zones per county. The IDOT_2021 folder lists the 33 new LDP zones.

B Select Geographic Coordinate System

Library  Search
B0 Favortes Coordinate System a~n
PSG:26771 - NAD27 / llinois East
EPSG: 102672 ]
26772 - NAD27 / llincis West NAD 1983 StatePlane lllinos |
PSG:102671 - NAD 1983 StatePlane llinois East FIPS 1201 Feet Transverse Mercator
PSG:3444 - NADB3(HARN} / llinais West ftUS) o
PSG:3443 - NADB3(HARN) / llinois East ftUS) ESRI PRJ [AcGIS]
PSG:2436 - NADE3 / llinais West ftUS) US Survey rm,:
H PSG:3435 - NADB3 / llincis East ftUS) 90°10°00.0000"W
DoT 36°40°00.0000"N
1DOT_2021 0.99994118
G Library 2296583.3330
0.0000
Positive X and Y
92°15'00.0000"W
87°4500.0000"W
36°00°00.0000"N
43°00'00.0000°N
~
NADE3
North American Datum of 198]
US Defense Mapping Agency.
NADE3 - no shift required
v
Corcel

10) Double Click on EPSG:102672-NAD 1983 StatePlane lllinois West FIPS 1202 Feet under your Favorites.
11) Close the Geographic Coordinate System Dialog.

Reference Needed information to Current Design

1) Select the Survey Workflow from the drop-down menu. Many of the commands you will use in this exercise are
in the Survey Workflow.

|0penRoads Modeling .| = & [operRoadsModding [ HE € - 22 kX = CA\Users\needhamim\Desktop\LeanneWorkAtHomeFiles_Folders\lz

File Home Terrain Geometry Site Layout Corridors Model Detailing Drawing Production Drawing View

u OpenRoads Modeling ymetn
OpenRoads Drawing Production @ [None + | [Default - Q [ @8-=- * i _a; y b Tabs
e e
* Survey Workflows L= == = + A = Attach E_ _‘L Reports Civil Corridor
< Eo =0 =0 Q0 50 kiploter Tools~ %% ~ G ~ & Analysis* Reports~
H Geotechnical v :
Reality Modeling Attributes Primary Selection Model Analysis and Reporting

Drawing Q? |Nn Feature Definition v ‘g? 4 + A :ﬁ'ﬁ 8 £ ‘7\ X GrGUES | [~

Note: Workflows segment tools into discipline specific groups streamlining the interface. Each Tab

Group further segments the Survey tools to a task-based interface.

2) From the Home tab select the Attach Tools -> References, located in the Primary Group.

LOrraors WITOEl L'etaling Lraw

Dl

Explorer Attach _ : Elermne
Tools » }:"IE * B Selecti

[E| References Sel

!"'i"' f& ﬁ Raster Manager i ’
{3 Point Clouds
#)  Reality Mesh

Gy G
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3) Inthe Reference File Dialog, select Tools -> Attach and attach the following files from the Chapter 4 folder. The
Section Corners.dgn file is already attached but turned off.
e Aerial Topo
e EX_ROW
e PR_ROW
e Existing Alignments in the Existing Alignments folder
e Master PR Alignments in the Proposed Alignments folder
Note: A message box will pop up saying the files do not belong to the current WorkSet. This is fine, so just click
Ok to continue.

£ Alert X

'E Selected file(s) do not belong to the active WorkSet. Do you want to
L] continue?

[] Do not display again.

4) Turn on the display of the Section Corners.dgn file in the Reference dialog so it shows up with the rest of the
references. Close the Reference dialog once all files are displaying.

5) Parcels 6021107, 6021108, 6021134 have already been setup along with their temporary easements and ROW
takes. In the next section we will learn how to setup our parcels using the Geometry Builder tools.
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E4.2 - Creating Parcels with Geometry Builder
1) Find Parcel 6021109, 6021110 and 6021111 in the Northwest corner of the project and examine the details for
each parcel. We will be setting up a label later for each Parcel.

2) Asyou can see Parcels 6021107, 6021108, 6021134 are on a new level. Select one of the parcels and Select
properties. After reviewing the properties select again in a blank area to clear your selection set.

Bylevel (2)
No Fll

(None)

0

o

IS

2400503 406", 1155645 668
2400503.406",1155645.668
1609175.649 Sa.

5161.89
No
IS

ROW_PR_Design and Parcel f
6021107

Extended -
Defauit
- 4777202271527 M
Sold Solid
i Not Modifed
New
Locked Unlocked
Line Sy Parameters:
Dispay Swyle 5] (From View Display)

3) Inthe Feature Definition Toggle Bar, select the Linear\Right_of_Way\
ROW_PR_Design_and_Parcel_Information feature definition from the drop-down menu. Toggle on the Use
Active Feature Definition toggle at the beginning of the toolbar.

(?2 ROW_PR_Design_and_Parcel_Information 7|

Explorer v X

nd \N
4) In the Survey workflow, on the Geometry tab, in the General Tools group, select the arrow next to Standards
and select Set Feature Definition from the drop-down menu.
Survey - a8 Ht'f - - j':']:

E Home  FieldBook  Analyze  Edit  Terrain  Geometry

i k s < Import/Export ~ e 7, ) c
) T

@3 Design Elements = -

Element ., Civil Reports | Lines A
3] Selection ..} *  Standards * Toggles e -
mary Selection W Set Design Standard
J|Row_PR_Design_and_ 82 Design Standards Toolbar _zlu A y :
Properties "% SetFeature Definition i xX

¥  Feature Definition Toolbar
4 “rp tlements (1)

4 7 Complex Hlet @  Match Feature Definition

Civil Message Center v

General {0 Set Element Information A

Element Description B Speed Table

[ DA DD Piarice —md Dol Iefnd
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5) Inthe Tool Settings Dialog set the following properties: Tip: hit Enter after keying in the name.
e Feature Type: Linear

e Feature Definition: Linear\Right_of_Way\ ROW_PR_Design_and_Parcel_Information
e Name: 6021109

6(_?,.

Feature -~

Feature Type | Linear v |

Feature Definition |ROW_PR_Design_and_ParceI_Inforrnation w |

Name 6021109 |

6) Select Parcel 6021109 and Right Click to accept it. You will need to hit Right Click again to clear the selection.

Note: Sometimes it does not hold the name and you will have to select the parcel and go to Quick Properties to
change the name. You can avoid this by hitting Enter after typing the name in the Tool Settings Window.

Start Point 2400519.336°. 1154685 95

End Point 2400519.336°. 115468595
Length 9190.080°

Feature Definition ROW_PR_Design_and_P=

6021109

7) Follow the same procedure for Parcel 6021110 and 6021111.
8) Then we will do the same procedure for the ROW takes and the Temporary Easement.
e For the ROW Takes
i) Feature Definition: Linear\Right_of_Way\ ROW_PR_Design_and_Parcel_Information
ii) Name: 6021109_Take, 6021110_Take and 6021111_Take
e Forthe Temporary Easement
i) Feature Definition: Linear\Right_of_Way\ ROW_Pr_Temp_Easemt
ii) Name: 6021111_Temp_Easemt
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9) Open the Reference dialog and Turn Off the EX_ROW and PR_ROW. You will be able see the SS10 calculated

parcel behind it. Turn On the references when you are done viewing.

10) In the Survey workflow, on the geometry tab, in the Horizontal group,
Geometry and select Geometry Builder from the drop-down menu.

select the arrow next to Complex

1 Geometry Drawing Production Drawing Utilities Collaborate View
0 g O . & Offsets and Tapers ~ \j“; f’f BB Open Profil
L ) A Reverse Curves = ) 3 Set Active F
sports | Lines  Arcs  Point Modify | Complex
= - B v 2 Spirals ~ v Geometry* | Profile Crez
Horizontal #  Complex By Element
‘-'(,—Bl.,\ :5 / Complex By PI
1 x : Define By Best Fit
B View 1, Default ;
= _;( L1l @ Geometry Builder

3

,
I )

11) In the Geometry Builder Tool select the fourth tool over, Add new geometry.
12) Select the Element selector inside the geometry builder tool in the upper right corner.
13) Then select the 6021109 parcel and data point to populate the Geometry Builder tool with the parcel

information.

14) In the left pane at the top of the Geometry Builder dialog change the name from NewGeometryl to Parcel

6021109. Right above the name pick the drop down for Feature Definit
ROW_PR_Design_and_Parcel_Information.

ion and set it to Linear\Right_of_Way\

:J Geometry Builder Tool

HE 3 % X3¢

No Feature Definition X: 2400519.33¢'

=D Djj Bearing

¥: 1154685.958' +- Begin Point

v Deg Min Sec = Survey Feet

.7"1{)0\/\/ }Jk=

Distance Hand
959.842

30237

Bearing
NOO°5703.4"W
S71°08526"E
ST104082°E
559°38015"E
SBZ11471°E
S70718571"E
S69°46155°E
S62°1809.3"E
S01°05251°E
S01°1658.2"E
S735553.2"W
S01*16%575"E

Arc
3

RT ARC
50.920°
50.920°
5.201
47685
474 8100
/2Ny
471.708
Exriaby
1510.3.

RT ARC

Chord

i

Ac

Radius ~ Chord #

mx <@ >

Place Non-Tangent Complex Civil Element Un-Ruled

&\ Begin Point = Mo Line ~ %

- Perimeter=[9190.080'] Area=[2621981.255'2{60.192a)] Closure=[N%0°00'00.0"W 0.000]

Place Close
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15) Click on the Save As button at the top of the Geometry Builder dialog and navigate to the Parcels folder in
your data set and save the file as Parcel 6021109.xml.
9|
2 v 4 > L494L13430 > OSDisk (C) > Users > shawj > Desktop > IDOT Survey Training 2022 > ROW and Plats > Parcels v o

Organize v New folder = @

N Name

0 1494113430
J 3D Objects 602107 ROW.xml
[ Desktop 602108 ROW.xml
6021134TExml
Parcel 602107.xml
Parcel 602108.xml
Parcel 6021134.xml

<] Documents
& Downloads
D Music

&= Pictures
B Vvideos
‘aa OSDisk (C:) v
File name: | Parcel 602109.xml -

Save as type: GeometryBuilder XML Data (*.xml) v

A Hide Folders Save Cancel

16) To setup for the next Parcel export, click the last button at the top of the Geometry Builder dialog, Delete All
Items. When the dialog appears asking Delete All, click Yes.

IMPORTANT NOTE: You must use the SAVE AS command within the Geometry Builder dialog to save your
XML output. If you mistakenly hit the Save button it will overwrite the XML file that is listed in the Top Bar of the
Dialog and force you to go back and recreate your output file.

To clear the settings within the Geometry Builder, so you don’t risk overwriting your file, you have to

close the Dialog and restart OpenRoads Designer. Otherwise, the file you just created is held as the default Save
Name / Location and will be overwritten if you do another Parcel.

If you are presented with a Dialog box asking you to save to the file when you close the Geometry
Builder dialog, click NO otherwise you will overwrite the current XML file that you exported. This is a current
limitation of the software, and Bentley is working to fix it in a future release.

17) Using the steps above, create the other Parent Parcels, ROW takes and Temporary Easements for Parcels

6021109, 6021110 and 6021111 using the following information.

e For the Parent Parcels
i) Feature Definition: Linear\Right_of_Way\ ROW_PR_Design_and_Parcel_Information
ii) Name: Parcel 6021110 and Parcel 6021111

e Forthe ROW Takes
i) Feature Definition: Linear\Right_of_Way\ ROW_PR_Design_and_Parcel_Information
ii) Name: 6021109 ROW, 6021110 ROW and 6021111 ROW

e For the Temporary Easement
i) Feature Definition: Linear\Right_of_Way\ ROW_Pr_Temp_Easemt
ii) Name: 6021111 TE

Note: By Saving your Parcel .xml files you can place all the Parcels in one dgn or if you are creating a Plat for one
certain parcel you will be able to only load that Parcel into your dgn.

18) Close the Geometry Builder dialog after selecting the Delete All button. When prompted to Save Changes to File,
select NO, otherwise the current file listed in the Dialog box header row will be overwritten with a blank file.
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E4.3 - Create a Single ROW Plat or Plat of Highways

1) Go to File then select New and create a new 2D file named Parcel 6021109.dgn in the Chapter 4 folder.

2) Set the Geographic Coordinate System (GCS) and then attach the following references.
e Section Corner

Aerial Topo
e Existing Alignments in the Existing Alignments folder
e Master PR Alignments in the Proposed Alignments folder

2) Close the Reference dialog box and do a Fit View to see all the referenced files.

3) On the Survey workflow, in the geometry tab, in the Horizontal group, select the arrow next to Complex
Geometry and select Geometry Builder from the drop-down menu.

4) If there is anything listed in the Geometry Builder dialog, select the Delete All Items button, and select Yes in the
dialog that pops up.

5) Choose Open, if prompted to Save Changes to file select No, and navigate to the Parcels folder and select the
Parcel 6021109.xml file.

£ Geometry Builder Tool - Parcel 602109.xml - X
ROW_FR_Design and Parcel Information  + | X: 2400519.336' Y: 1154685.958' < Begin Point
6021109 g )
[TT] Bearing - Deg Min Sec - Survey Feet Bt~ v, / / @ > k
Beating Distance Type  Hand  Ac Ac Ac Radius Arc Length =
»  |NDOST034"W |959847 line v Radius - | Arc Length - |0.000 0.000 A
S7I'08526'E  |30.237 line v Radius - | Arc Length - [0.000 0.000
=]
S7I'04082°E  [105.326 ac | RT || ARC | Radus - - |38202.767 105.326" =
S59°38015E  |50.920 line Radius - - [0.000 0.000 3
SEZI1471"E 509200 line Radius - - |0.000 0.000 =
STB571"E  [699.201 Ac | AT || ARC | Radius - - |38202.767 699.217"
SE9'46155°E  |47689° lne v Radus - - |0.000 0.000
S62'1B093'E  |474810° line v Radius - -
SOT'0525.1"E  |392314° line - Radius - -
SOT"16582°E  |471.709° line Radius - -
S§73'55532'W (932217 line Radius - -
S0116575°E | 1910.360 line Radius - -
SEYI5479"W  |436.540° lne v Radus - -
ND1“1614.8"W | 2627588 line v Radius - -
. o o o
Place Non-Tangent Complex Civil Element Un-Ruled Flace Close
< > | |5\ Begin Point = Add Line = % ~ Perimeter=[9190.080'] Area=[2621981.254'2(60.192a)] Closure=[NG326'05.8"W 0.000']

6) Place Parcel 6021109 in the DGN by selecting the Place button in the lower right corner.
7) Continue in Geometry Builder and Open 6021109 ROW.xml select and place the ROW into the file by selecting
the Place button.

£ Geometry Builder Tool - 6021109 ROW.xml - X
oHE T %R XX
ROW_FR_Design_and_Parct = |! X: 2400503.406' ¥: 1155645.668" -~ Begin Point
6021109 ROW g i
m Bearing + Deg Min Sec * Survey Feet -7 /(é) \va / } * -
Bearing Distance  Type  Hand At Arc Arc Radus  Chord  |ugy
3 ST108526°E (30237 |Line  ~ Radius ~ | Arc Length ~ | 0.000 0.000 X
S71°04082°E  [105326 |Ac v | RT ARC | Radius ~ | Chord ~|382027.. | 105326 a
559°38015"E | 50.920° Line - Radius = | Arc Length - | 0.000 0.000 N
SE21147TE (50920 |Line  ~ Radius ~ | Arc Length ~ | 0.000 ~
S701857.1"E  [699.201 |Ae v | RT ARC | Radius ~ | Chord ~|382027.. 699201 =
S69°46155'E | 47.68Y Line = Radius v | Arc Length - [0.000 0.000
SEZIG09.3E 474810 |Line  ~ Radius ~ | Arc Length -
SO1°0525.1"E 50488  |Line  ~ Radius ~ | Arc Length ~ | 0.000 0.000
N70°49%52.2"W | 151.535 |Ac v | LT ARC Radius ~ | Chord - [19860.0.. | 151535
N71°0259.1"W | 1270524 |Line  ~ Radius ~ | Arc Length ~ | 0.000
NOO'5703.4"W | 137.444' |Line  ~ Radius ~ | Arc Length -
. o o o
Element placed
< > | |5 Begin Point + Mo Line ~ %7 + Perimeter=[3069.110'] Area=[159845.974'2(3.670a)] Closure=[N53°07'48.4"W 0.000')

8) Close the Geometry Builder dialog, making sure not to save it to the file if prompted.
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9) Zoom into the Parcel and ROW for parcel 6021109.
10) Under the Geometry tab, in the General Tools toolset, select the arrow under Reports to see the reports

available to run.

yze  Edit  Temain | Geometry  Drawing Production  Dra
port ~ B 75 2 , L Offsetsand Ta
ments T j(’ o O ¢ X Reverse Curve
i Civil  Reports | Lines Arcs Point

Toggles= |+ - - * 2 Spirals

General Tools

Horizantal Geometry Report

{ S

_ [Cle

A Horizontal Point Report

Profile Report
87 Legal Report
Map Check Report

Station Offset Report

Station Base Report

8 Superelevation Repert

Point Feature Station Offset Elevation Report

Illinois Department of Transportation
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11) Select the Map Check Report from the listing of available reports. Select the parent parcel 6021109 on your
screen and then Right Click to display the report. At the bottom of the Map Check report, you can see the
closure error if there is one. By selecting the Parent parcel or the ROW take you can review the Map Check for

each parcel.

Alignment Name: Parcel 8021102

Alignment Description:

Point Hame/

Mo rthings!

Type Direction Length Easting Henfion
START ] 1154685 858 2400519.236 0.000
NO.951T"W 959,842
HFI ] 1155645868 2400502406 0.000
571.148°E 20.232
PC ] 1165635.888 2400522.017 0.000
S518.852°W 38202.761
cC ] 1119482 487 Z38B187.718 0.000
519.010°W 28202 781
FT ] 1165601.728 2400821645 0.000
S559.634E 50.820
HFI 1] 1165575887 2400875580 0.000
582 186°E 50.820
PC 0 1155580.072 2400726.028 0.000
519.180°W 38202781
cC ] 1119482 487 2388187.718 0.000
520.208°W 28202.761
FT ] 11565333 557 2401284371 0.000
58877 1°E 47.889
HFI 0o 1155317.068 2401428.118 0.000
562 0FE 474810
HFI ] 1165086.275 2401848 622 0.000
51.080°E 382 314
HFI ] 1184704132 2401858 5687 0.000
51.28F°E 471.709
HFI ] 1164232 B4 24018687 548 0.000
573.931°W 932 217
HFI ] 1163874 615 2400571.752 0.000
51.282°E 1910.260
HFI 1] 1162084 824 2401014514 0.000
S589.283°W 428.940
HPI 0 1152069.016 2400577 810 0.000
N1.271°W 2627.588
HFI ] 1154685.8958 2400519.236 0.000
N45.000°W 0.000
END ] 1154685.858 2400518.236 0.000
Morthing Error: 0.000 #
Easting Error: 0.000 #
Closing Direclion: 583 435°E
Clesing Distance: 0.000 #
Closed Area: 2821881.254 sq ft 80152 ac
Perimeter: 9120.080 f
Precision: 21521380132397 : 1

12) After reviewing the Map Check Report, Click on File -> Save As, in the next branch of the menu select Microsoft
Word (.doc) and save the file in the Chapter 4 folder named Parcel 6021109 Map Check.doc. Close the Map
Check Report dialog box.
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Sheeting and Labeling the Parcel / Plat
1) Continue in the Parcel 6021109.dgn file and go to the Drawing Production tab in the Survey Workflow. On the
Named Boundaries group select the Arrow next to Named Boundaries and select Place Named Boundary from
the drop-down menu.

2)

igator

Boundary =

- 1"=50'
4 ACSPlane Lock

i
hEah
Mﬂ_‘Annotation Scale

Named

i Nam :_‘-'_(' Place Mamed Boundary

gt Adjust Profile Named Boundary

- Plat from the Drawing Seed drop down box.

3)
4)
5)
6)
7)

Tllinois Department of Transportation
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Drawing Seed:
Detzil Scale:
Name:
Description:
Group:

Mame:
Description:

Start Location:
[ Stop Locatien:
Length:

Left Offset:

Right Offset:
Overlap:
Boundary Chords:

4% Place Named Boundary Civil Plan — ®

Ee®./ 700

ROW Plan - Plat =
1"=100" -
Parcel 6021109

(New) <

1L57

3000.000000
-1000.000000
1000.000000
0.000000

5

Create Drawing
Show Dialog

Boundary will show up.

8)

then the Create Drawing Dialog box will open.

9)

In the Name field enter Parcel 6021109 and hit Tab. If you want to put a Description in, then do so.
Set the Detail Scale to 1”=100" from the drop down list.
Toggle on Create Drawing at the bottom of the dialog.

Pick the Proposed Center Line Alignment of IL. 97 to select your stationing.
Toggle on Start Location and key in Start Station of 583+00 and Data Point on your screen to accept it. A

In the Place Named Boundary dialog box choose the first icon in the top menu, Civil Plan then select ROW Plans

Pick near the middle of the sheet boundary to create only one sheet. You will need to Datapoint two times and

In the create Drawing Dialog, Under Drawing Model change the Annotation Group to Plan Annotation D6. Make

sure all the field are as shown below. Make sure that the Drawing Model Scale and the Sheet Model Detail
Scale Match, in this case they both need to be 1”=100’". Pick OK and a drawing and sheet model will be setup.

i

|

View Name:
Drawing Seed:
View Type:
Discipline:

Purpose:

Model Name:
Seed Model:

Filenarne:
A

=]

Mode:

Plan

One Sheet Per Dgn:

ILS7 - Parcel 6021109

ROW Plan - Plat -
Civil Plan

Right of Way

Plan View

Drawing Model

ILS7 - Parcel 6021109
Civil_ROW_Named_Boundary_Sheet5eed
(Active File)

1"=100" -

A
]

Annotation Group:

Model Name:
Seed Model:
Filename:

Sheets:
A

[m]
Drawing Boundary:
Detail Scale :

1"=100 -

o |

|Plan Annatation D6

Sheet Model

ILS7 - Parcel 6021109
Civil_ROW_Named_Boundary_SheetSeed

(Active File)

(New) -
Full Size 1 =1 -
ROW Plan - Plat -
1"=100' -

[] Add To Sheet Index &2

Make Sheet Coincident
Open Model

Cancel
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10) Using the Active View Groups selection box in the lower left corner of your screen select Default to go back to

your default view.
m
MName Model
[ Default O1Default
[C11L97 - Parcel 6021109 [Sheet] Views [ 3IL97 - Parcel 6021100 [Sheet]
{E11L97 - Parcel 6021109 Views [ IL97 - Parcel 6021109

5 - [ Defauit =10 BBABEEOEX P
T e e

11) On the Explorer tab choose Open Road Standards. Click on the Arrow next to the Standards to see what is listed

under it.
12) You will see Parcel 602109.dgn right click on it and choose Update Standards from dgnlib. This will ensure that

all the Item Types are loaded into the current dgn.
13) Then on the Utilities tab in the Item Types section choose the Micro Icon in the lower right to open the Item

Types manager.

O
v v . W = v >
¥ s X Lm VS
Asset  Attach Detach Picklist Import/Export  Reports
Manager Item  Iltem
Item Types Reports

Flof @ A /[, vemone

v 0 % | Explorer Managg custom item types and their
properties

14) In the Item Types Manager under Assets right click on Ownership and select Attach to Element. Pick the Parcel
and ROW Take to add the Item Type to them.

) Item Types B .
Libraries  Utilities
& @ %@ [ X X
a
4 Gy Assets Properties
> ttem Type -
b [ Sign Item Name “Ownership”

Use ltem Name for Element No

4 K Location

b [ Station

b [ Station Offset
4 R Pay ltems

b [ Pay ltem - LandScaping

15) Close the Item Types Manager and Attach Item dialog boxes.
16) Go to your Explorer and pick on the Items Tab and pick on the down arrow next to Ownership. When you click

each ownership ltem type the one you choose will highlight and in the properties box you will be able to fill in all

the information for that Parcel.

t’.?::'? |N0 Feature Definition w |€P{“? A
Explorer ~ax|
| Survey
| OpenRoads Standards |~ Drainage and Ltilties Model
¥ ltems |- OpenRoads Model @& Sheet Index B Links
b Q /® -
|.5r'§.-'o".'- P |/C=) ¥

4 [ Ownership

< Ownership
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17) Go ahead and fill out the Ownership box in the Properties Dialog for the parent parcel with the following

information:

e Parcel No.: 6021109

e Description: 13-17.0-400-008 (006 pt)

e Owner: William R. Larsen, JR. and Kathryn A. Grobis,

e Owner2: Trustees Under the Irrevocable Trust Agreement of William R. Larsen
e Date: April 11, 2019
e Document: 2019R12124

e  WTC#: 16-2019SN-2249.0

—

=

Properties (ltems) * 0 x

4 [ Ownership (1)
4 < Cwnership

P Parent

Ownership

Parcle Mo.
Description
Owner
Owner 2
Date

Doc No.
WTC No.

Run the Legal Description Report

1) On the Home tab under Model Analysis and Reporting. Select the arrow under Reports and select Legal Report
from the drop-down menu.
€l survey A=l - | 4l b =
IE tome  FicldBook  Anshze  Edit  Temain | Geomety  DrewingProduction  Drev
=Y Z Import/Export * b 24 ] > 2 Offsets and Tay
5 - k 3 Design Elements = ! L4 O _L X Reverse Curve:
Element -, Civil  Reports  Lines Arcs Point
@1 Selection £ * 9 Standards ~ Toggles - - - v 2 Spirals ~
Primary  Selection General Tools 7 Horizontal Geometry Report
5}::2 |ND Feature Defintion ~| ¥ Horizontal Point Report
Explorer > X Profile Report
& Sheet Index s Links OpenRoads Standards 87 Legal Report
|-} Drainage and Utiities Model | Survey 7 Map Check Report
Fle & Mems [5i Resources OpenRoads Model # Stotion Offset Report
Ome: . .
_ #”  Point Feature Station Offset Elevation Report
[Seareh Plew Station Base Report
4 () Ownership | !‘" Superelevation Report
2) Inthe lower left it asks you to Locate First Element, select the 6021109 ROW, then Right Click to reset.
3) Inthe lower left the software ask you Locate Parent , select Parcel 6021109.
4) Inthe lower left the software asks you Locate Primary Reference, select the Proposed Centerline Alignment.
5) Primary Reference Alignment Bandwidth refers to a point where station offset callouts lose their relevance.
Normally you would set to a couple hundred feet off the alighment to pick up all the Station-Offsets.
e Set Input Bandwidth to 250’ and hit Enter to lock in the keyed value and data-point to accept.
6) Inthe lower left the software ask to Locate Secondary Reference, Right Click to reset.
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7) The Legal Report will open, it will show the legal description of the Parent Parcel and the Right of way take.

Property Description

Report Created: Tuesday, June 14, 2022
Time: 1:24:18 PM

Project: Default
Description:
File Name: F-JAMIE BACKUP FROM LAPTOP 5_10_20220DOT Survey Training 2022\ROW and Parcels\Parcel 6021109 dgn
Last Revised: 6/14/2022 12:54:16
Input Grid Factor: MNote: All units in this report are in feet unless specified otherwise.

Alignment Name: Parcel 6021109
Alignment Description:

Beginning at a point 913 285 feet right of IL97 at Station 592+24 513 thence North 00°57'03 405" West a distance of 959 842 faet to a point 10.764 feet right of IL97 at Station 588+97.784 thence South 71°08'52 558" East a distance of 30 232 feet to a
point 10.712 feet right of IL97 at Station 589+28 016 thence along an arc 105.326 fest to the right, having a radius of 38202 761 feet, the chord of which is South 71°04'08 220" East for a distance of 105 326 feet, to a point 10677 feet right of IL97 at
Station 530+33.342 thence South 59°38'01.453" East a distance of 50 920 feet to a point 20756 feet right of IL97 at Station 580+83 255 thence South 82°11'47.076" East a distance of 50 920 feet to a point 10 912 faet right of IL87 at Station 591+33 214
thence along an arc 699211 feet to the right, having a radius of 36202 761 feet, the chord of which is South 70°18'67 054" East for a distance of 699.201 feet, to a point 19.868 feet right of IL97 at Station 598+32 358 thence South 69°46'15 451" East a
distance of 47.689 feet to a point 20.932 feet right of IL97 at Station 598+80.035 thence South 62°18'09.316" East a distance of 474.610 feet to a point 92.686 feet right of IL97 at Station 603+49.949 thence South 01°05°25.068" East a distance of 392.314
feet to a point 459.851 feet right of IL97 at Station 604+90.095 thence South 01°16'58.204" East a distance of 471.709 feet to a point 839.419 feet right of IL97 at Station 606+67.271 thence South 73°55%3.237" West a distance of 932.217 feet to a point
1439.248 feet right of IL97 at Station 598+83.447 thence South 01°16'57 481" East a distance of 1910.360 feet to a point 3228.501 feet right of IL97 at Station 606+07 482 thence South 89°15'47.901" West a distance of 436.940 feet to a point 3378.926
feet right of IL97 at Station 601+32.720 thence North 01°16"14.849" West a distance of 2627588 feet to a point 913.285 feet right of IL97 at Station 592+24 513 thence North 45°00°00.000" West a distance of 0.000 feet to a point 913.285 feet right of IL97
at Station 592+24 513 and the POINT OF BEGINNING.

The above described parcel contains 60.19 acres (262198125 sq. )
Alignment Name: 6021109 ROW
Alignment Description:

Beginning at a point 10.764 feet right of IL97 at Station 588+97 784 thence South 71°08'52.558" East a distance of 30 232 feet to a point 10.712 feet right of IL97 at Station 589+28.016 thence along an arc 105 326 feet to the right, having a radius of
38202.761 feet, the chord of which is South 71°04'08.220" East for a distance of 105326 feet, to a point 10.677 feet right of L7 at Station 530+33 342 thence South 569°38'01.453" East a distance of 50 920 fest to a point 20.756 feet right of IL97 at
Station 590+83.255 thence South 82°11'47.076" East a distance of 50.920 feet to a point 10.912 feet right of IL97 at Station 591+33.214 thence along an arc 699.211 feet to the right, having a radius of 38202.761 feet, the chord of which is South 70°
18'57.054" East for a distance of 699.201 feet, to a point 19.868 feet right of IL97 at Station 598+32.358 thence South 69°46'15.451" East a distance of 47.689 feet to a point 20.932 feet right of IL97 at Station 5986+80.035 thence South 62°18709.316" East
a distance of 474.810 feet to a point 92.686 feet right of IL97 at Station 603+49.949 thence South 01°05'25.068" East a distance of 50.498 feet to a point 140.000 feet right of IL97 at Station 603+67.698 thence along an arc 151.535 feet to the left, having a
radius of 19860.000 feet, the chord of which is North 70°49'52.227" West for a distance of 151.535 feet, to a point 140.000 feet right of IL97 at Station 602+15.094 thence Morth 71°02'59.145" West a distance of 1270.524 feet to a point 140.000 feet right of
IL97 at Station 589+44 570 thence Morth 00°57'03 405" West a distance of 137 444 feet to a point 10.764 feet right of IL97 at Station 5858+97.784 thence North 53°07'48 368" West a distance of 0.000 feet to a point 10 764 feet right of IL97 at Station
588+97.784 and the POINT OF BEGINNING.

The above described parcel contains 3 67 acres (169845 97 sq. ft.)

8) You can see various formatting for the reports by selecting different style sheets in the left pane.

9) Select Property Description Extended in the Report Styles list and in the Tools drop down menu select Format
Options.

10) Under the Precision column change all fields that are three decimal places to two decimal places.

11) Change Angular to ddd*mm’ss” under the Format column.

12) Close the Format Options dialog box. You only have to change the Format options once and the setting will be
maintained.

£ Bentiey Cril Repor Browser - €:\Usarsineedhamim\AppDastaiLocaliTamp 1\ RPEedbnoudxmi - a *

Designer CONNEC

Property Description

Report Crested: Friday. Septamber 18, 2020
Time: 3.27.00 PM

Project; Default
Description:
[ \DeskloplL dos_Folders\JamiesSunveyTramingWideosTaTextiROW
File Name: i Piare\Parcels. dgn
Last g r
91872020 14.51.04
Revisad | &4 Format Options X
input Grid
Factor: | Mode Precision Farmat
Close
Alignment Hame: ParentParcall L e Help
Abirmerk Descripiién orthing/Easting/Elevation: 012
Angular: Degrees ~| 012 || deddad v
Beginning at & point thence Narth 01°1512 041 e Deg
« of 780,368 feet thence South 41°05 Slope: 12 ~||os v i
5t a distanca of 241 085 fest thence Sauth 83 —
419451 feet to the leh, having a radius of 40500.351 fest, the| Use Alternate Slope if Slope Exceeds: ] 1
distance of 419 449 feat and the POINT OF BEGINNING 01
3 Alternate Slope: 0.5
SR The above described parcel contains 1061 actes (46217.816( 012
ShowilLs! Linear: 2123
Station: 01234 ss+5555 “ | Delimiter:
Acres/Hectares: e
Area Units:
Cubic Units: Convert to Cubic Yard
Direction: Bearings -] 123 * | | dddAmm'ss
Face: Right Face b

Vertical Observation: | zesytn

13) Go to File > Save As and in the menu branch select Word Document (.doc). Name the file 6021109 Legal
Description and save in the Chapter 4\Legal Description folder.
14) You can also print the report as a pdf from this dialog, or open the Word Doc and print it to PDF there.
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E4.4 - Labeling the Plat
1) Open/ Continue in the Parcel 602109.dgn

2) Make sure you are in the default model in the drawing and not one of the sheet models.
L=
- = ~ & Defautt k=l HEE
I

3) Under the Home tab, in the Selection toolset, select the down arrow next to the Fence commands and select
Place Fence from the drop-down menu.

B-<- .. & T @ A
B - & e =
Reports  Ciwil  Cor

El it
B v coocton L v Analysis = Repo

= .
‘e Selection

B %

Selecti Place Fence

Modify Fence

] Manipulate Fence Contents
efault

Delete Fence Contents

Drop Fence Contents

i SaveFenceto File

-
{5 Named Boundaries

4) Inthe Place Fence dialog, set your Fence Type to Shape and place a rectangular Fence around the Plat as shown
with the Green highlighted area.

5) Open the Reference Manager dialog and highlight all the References. In the tools across the top of the dialog
select the Clip Reference tool.

B References (4 of 4 unique, 4 displayed) - X
Tools  Properties
E B (o220 B 07 @ 0 tevor b -
Slot = Model Description Logical COrientation Presentation
1 HETT Default Master Model Coincident - World Wireframe
2 Section Cerners.dgn Default Master Model Coincident - World Wireframe
3 LAEXISTING ALIG...  Default Master Model Coincident - World Wireframe
| 4 AMaster PRA.. Default Master Model Coincident - World Wireframe |
< >
Scale | 1.000000000 :| 1.000000000 Rotation | 00°00'00"
Offset X | 0.000 ¥ | 0.000
II‘!"‘"- _u =] |:| [ Mested Attachments: | No Nesting ~ | Mesting Depth: | 0
Display Overrides: | Allow = | New Level Display: | Config Variable ~ | Georeferenced: | No A
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In the Set Reference Clip Boundary dialog make sure the Method is set to Active Fence and that Use References

Dialog List is checked. Data point in your design plane to Clip all the references around your Plat.

J% Set Reference Clip Boundary

-

Active Fence
[] Discard Existing Clip Masks
Use References Dialog List

Method:

*

7) Close the Reference Manager dialog and do a Fit View to see everything that is left in the view plane.

8)
from the drop-down menu.

a-e-
Q BTk
P ftse g8~ Seecton L1 -
Primary 7 Key-in
'+A ;;".. }, [3 Toggle AccuDraw
x g‘;] Auxiliary Coordinates
= Viewl, IE}IefauIt Zw_“:] Saved Views
lod ~ O % ~ | e e
Markups

Details

Window List

9)

Under the Home tab, in the Primary toolset, select the down arrow next to the Key-In command and select Cells

In the cell library dialog box select File -> Attach File. Navigate to the IDOT_Standards\Cell folder location and

select the IDOT_Plats.cell to load it. In this library we have access to the common cells that are used with Plats.

4 Cell Library: [C:\IDOTCAD_ORDAConfig. AIDOT_Plats.cel]
File
T
237
= Mame Description Type al

[ &= Basis of bearing basis of coordinate and bear... Graphic |

% Curve Abbreviations  Curve Abbreviations Graphic

%2 D1-Proposed Parcel... Parcel No. Legend Graphic

S D2-Proposed Parcel... Parcel No. Legend Graphic

%2 D3-Proposed Parcel... Parcel No. Legend Graphic

%2  D4-Proposed Parcel... Parcel No. Legend Graphic

%2 D3-Proposed Parcel... Parcel No. Legend Graphic

&= D6-Proposed Parcel... Parcel No. Legend Graphic

%2  D7-Proposed Parcel... Parcel No. Legend Graphic

S DB-Proposed Parcel... Parcel No. Legend Graphic

%2 D9-Proposed Parcel... Parcel No. Legend Graphic

2 lenend far Ahhrevi  Akhresviatione Granhic hd
£ >

*

Page 108 of 131

OpenRoads Designer CONNECT Edition
Chapter 4 — ROW, Parcels and Plats — EXERCISES



Illinois Department of Transportation
Technology Policy and Support — CADD Support Unit

10) Change your model to the IL97 - Parcel 6021109 model using either the Model Manager dialog, or the Model
selector as shown.

e g |

ck MName Model |
[C Default Q1 Default

—l|-_.|':| ILS7 - Parcel 6021108 [Sheet] Views [ 31197 - Parcel 6021108 [Sheet]

_l_I'I_.:I IL97 - Parcel 6021109 Views [ 1L97 - Parcel 6021109

E'rﬂiﬂ IL‘J?—ParceIIS'DE‘H'D{vH'@“i”;llghlsl5|?|8| I-_-“ ,ﬁJ
_| .

11) Double click on the Surveyor Statement to make it the active cell for placement. Place it in the bottom left
corner of the drawing model, inside the drawing model named boundary. Repeat for the Right_of_Way Legend
and place it within the drawing model named boundary.

12) Under the Drawing Production tab, in the Labels toolset, select the Civil Labeler command.

Drawing Production Drawing Ltilities Collaborate
ABL
rABL Ar At i
T
lace = Place Place | Place Edit Change Text Ciwil
able  Mote Label Text Text Attnbutes .~ ™ |Labeler

ables Motes Text | Labels

13) In the Civil Labeler toolbox drill down in the left pane to Plan — Linear -> Name with Leader and select it. Right
click on the Name with Leader label and select Manage to see the Element Template options.

. © . _
/=, Civil Labeler Tool - Civil Labeler Imperial.xml = Chl Labeler Tool - Crvl Labeler Imperial.xm %
5 Givi Labels CivLabelerPlan-Geometry Name CHE % XX

-1 Cross Section
-~ Civil Labels Label  Placement
Plan - Drainage and Lkiities Method:  Select Elements Cross Section
Flan - General Leader: | Auto Left Right Plan - Drainage and tities Method: | Select Blemerts &
Auto Left Rig .
Flan - Intersections Plan - Gereral Lescer: [ Lottt <] Exension
Plan - Land Acq Fame (e Plan - Intersections
Plan - Linear Plan - Land Acq Frame: | None V| Offcer
v Plan - Linear
[7] Mlong Geometry - Elevation [Hori Divider: | Aone 7} Aong Geametry - Bevaton [Hor Divider ‘ Wone v‘
«[] Mong Geometry - Elevation [Rad ) Aong Geometr - Bevaton [Fad
«[] Mong Geometry - Blevation [Tan 7] Mong Geometry - Blevation [Tan| | Selection Use Selection Use Fence
[ Arc - Length L] Are-Length
[7) Arc - Length Radius [T] A - Length Radus Reference: [ Use Selection as Reference
[7] Arc - Radius [ Arc-Radus
) Prtwaon Geamety -Offset Rotation: |View Harizortal ) Bt Gy -Ofst Rotation: |View Horzortal
-] Between Geometry - Station Offs |} Between Geometry - Station Offs|
~[] Between Geometry - Stations Off 1) Eetween Geomesy - taons OF
] Lnear- Bea [ Linear - Bearing
near- Seaing [) Linear - Bearing and Length
[7) Linear- Bearing and Length [ Linar- Longth
[T Unear- Length L] Name.
[0 Name W] Hame wih Leader]
W] Vame with Leade-! Plan - Points
Plan -Poris |44 Manager | Plan - Survey Place Close
Pln-Svey [y g g Frfie
; an -
Puis P sy AR A
£ Collapse All
T < > | | Library : Labeler Text Favorites Dimension_Styles_Elem_Temp._Imperialdgniib : CivLabelerPlan-Geometry Name .-
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14) On the Label tab, set the Element Template to Civil Labeler ->Plan Annotation without Arrowhead.
15) On the Placement tab, select Place in the lower right corner and select the EX.IL97 centerline and place the
label. Then select the IL97 centerline and place the label again. Close the Civil Labeler Tool dialog.

NOTE: The Civil Labeler names the label according to what the Centerline is named in the Alignment file. So, you

can see the importance of naming conventions. You can also edit the text by double clicking on it and adding to
the label.

MILL

_ {0PT)-m

16) To place the Existing Curve Data, Open the Place Label command from the Notes toolset. Set the following

parameters in the dialog:

Select: Place a Label without a leader

Type: Text Favorite

Favorite Name: Curve Label RT — EX
Dimension Style: Plan Annotation without Arrowhead

4%"; Place Label Setting

r
Type:
Favorite Name:
Dimension Style:
Label Rotation:
Start At:
Harizontal Attachment:

Text Favonite v

€2 Curve Label RT-EX ~
&2 Plan Annotation with Ar ... Jy

Haorizontal v
Teminator -
Auto v

17) Pick the Blue Curve on the existing alignment and Data point twice in your design plane to place it. You can

move it after you initially place it.

18) Follow the same steps for the proposed curve on the IL97 Proposed Alignment and place the curve data next to
the existing curve data:

Select: Place a Label without a leader

Type: Text Favorite

Favorite Name: Curve Label RT — PR
Dimension Style: Plan Annotation without Arrowhead
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19) Select the Place Note tool command from the Notes toolset and place the two individual notes below at their
proper location on the plan. Set the Dimension Style to Plan Annotation without Arrowhead if it is not set.
e PCSTA589+27.92

e PTSTA 598+50.12
20) Go to the Home Tab and under the Primary tools select Level Display. In the dialog select the file IL97 — Parcel

6021109, Parcel 6021109.dgn, Default in the top pane and turn off the Alignment_PR_Notation level in the
bottom pane.

Setup a Text Favorite

1) Under the Drawing Production tab in the Annotations toolset select the little Arrow next to the Annotations to
open the text favorites manger.

Ao 4
Anﬁl:gt?gﬁ v Model[}[zurrlo?:gtion v gediogﬁ;igatw
! Annotations Review N
Text Favorite Manager

Text Favorite Manager

2) The Text Favorite Manager will open. Highlight Parcel 6021109 and then pick on the Green Plus Sign to create a

new Text Favorite in this dgn.
3) Name the new text favorite ARC_RAD_CB_CH in the left-hand pane by right clicking on it and selecting Rename.

A Text Favorite Manager

H + =1 X |y 120 Lefi-Center .

4 | Parcel 8021109.dgn Z R T
B | IDOTCAD Text Favorites_Text Styles [

b | Labeler Text Favorites Dimension_Styl

Select Element

Field Type: Select Field Type
Field Sub Type: | Select Field Sub Type
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4) Pick Select Element under the preview window and then select the Arc Between Station 589+00 and 590+00 on
the Proposed Alignment.

5) After selecting the arc a dialog box will open, under Elements drill down to Plan Annotation 2 levels under the
first Arc grouping.

6) Find the Arc Group in the dialog box and then move the dialog so you can access the preview area of the Text
Favorites Manager.

/ Line -

|| 4 % Elements (1) - Linear "
| 4 Complex Element: ILO7 | Point
b/ Line | Line

| 4 (7 A

? (¢ ¢ ¢

ARC
20000.000"
1309 420

cw

03°45'04 3667
-03°45'04 3667
007171132407

4 E_l Associated Elements (Driven)

|
/ Line

oo 654.944"

/ Line - ' :g z;

1 1309.186"
Linear w |~ 1 Ar tion 569°10°26 9617°E

7) Inthe Preview box of the Text Favorites Manager type ARC then a Space then choose the Arc Length in the
Elements box. By selecting the Arc Length in the secondary dialog, it will select it for you in the Elements box
within the Text Favorite Manager.

ABC
= 120_Engr Vert_Ctr Cir e | FG -

S S E S R B S S B S WS SR NS S BTN |

Select Element

Field Type: % Civil Element Properties

Field Sub Type: ¢ Plan Annatation

/D Linear Units Format Py
St - Label Format (Use Active Settings) v
Arc Type
[ Arc Radius Preview :0,000'
[ Arc Length +| v Save Preview reeen

Note: Do not worry if the Preview box does not show the exact number that you pick. Remember you are
building the text favorite.

8) On the right side of the Text Favorite dialog under Field Sub Type, there is a scroll bar that you use to see the
Linear Units Format and General Format options of the Favorite you are setting up. If you stretch the Text
Favorites dialog down, this section of the dialog will increase in size and be easier to work with.

9) In the Linear Units Format section for the Text Favorite set the following options:

e label Format: MU

Master Units: Survey Feet

Sub Units: Survey Inches
e Accuracy: 0.12

10) In the General Format section set the following options:

e  Suffix: ‘ (Apostrophe / Foot Mark)
e Decimal Separator: Period

Field Sub Type: | 7~ Plan Annotation v
[ Arc Length General Format -~
» Linear Units Format ~ Arc Hand Prefi
4 [ Arc - Label Format MU [ Arc Delta Suffix '
Master Units Survey Feet ] Decimal Separator  Period

Arc Type Sub Units ey | ¥ Arc Delta Signed Thou.sands Separztc (Mone)
—_—. - I eadina Fern Show

[ Arc Radius Accuracy 0.12

Page 112 of 131 OpenRoads Designer CONNECT Edition

Chapter 4 — ROW, Parcels and Plats — EXERCISES



Illinois Department of Transportation
Technology Policy and Support — CADD Support Unit

11) Check the Save Preview Box and then Pick Accept.
12) This puts the Arc Length into the preview box.

Preview :0.00'
' Save Preview Accept

13) After you have the Arc Length entered, select the preview window after the end of the text being displayed and
hit Enter on your Keyboard to start a new line in the Text Favorite.

14) Type RAD then a Space then choose Arc Radius in the Elements box, ensure that Save Preview is checked, and
then select the Accept button.

15) Use the same settings for the Linear Units Format and General Format for the Arc Radius.

16) After you have the Arc Radius setup, enter a new line in your Text Favorite and continue the same steps for the
Chord Bearing (CB), selecting Arc Chord Bearing from the dialog box. and the Chord Length (CHORD) selecting
the Arc Chord from the dialog.

17) In the Angle Format section for the Text Favorite set the following options:
e Format: DD MM SS
e Mode: Bearing
e Accuracy: 0
18) In the General Format section set the following options:
o Suffix: Blank
e Decimal Separator: Period
19) When you have completed the steps you text favorite should look like this.

Z---I---I---I---I

4 % Elements (1)

H + = X « 120_EngrVert CrCir e + || T Engineering Vert
y VE P

P Parcel 602109.dgn IR

PR -
4[] Associated Elements (Driven)

£~ Plan Annetation
3 IDOTCAD Text Favorites_Text Styles_Dimension Style

b Labeler Text Favarites Dimension Styles Elem Temp.

[y
N9S0°00°00.0000"E

2400532 0171155635 899"
2400631.645.1155601 728"

c
<

Select Element

24 i -~
Field Type: % Civil Element Properties
ARC
Field SubType: Plan Annotation 38202761
105.326"
L Linear Units Format - o™
00°09°28.6781"
 Dac - Label Format (Use Active Settings) 00°09'28.6781"
Wiaster Units (Use Active Settings) 00°08'59.9212"
Arc Type Sub Units (Use Active Settings) 52 663"
[ Arc Radius Acauracy (Use Active Settings) 0036
0036
[ Arc Length General Format ~ 105.326'
Arc Hand Prefix ST10408.2197°E
art N18'5107.4413°E
Bz o T N19°00'36.1194"E
[ Arc Delta Signed review 2 Dire t 571°08'52.5587"E
Direction End S70°59'23.8806"E
[ Arc Degree o = == Accept P — Y
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20) Once you have the ARC_RAD_CB_CH Text Favorite build click on the Save button in the top row of the Text
Favorite dialog box and close the Text Favorites Manager.

21) Under the Drawing Production tab in the Labels toolset select the little arrow next to the Labels to open the Civil
Labeler Manager dialog.

v /A A ABC

A ‘o) N )

4 Civil Element Drawing
A = Labeler Annotation~ Model Annotation =
& | Labels [5] Annotations I

Civil Label Manager
— Civil Label Manager |

22) In the Civil Labeler Manager Right Click on Plan — Land Acq and select New Label.
23) Rename the new label to ARC_RAD_CB_CH by right clicking on it and choosing Rename.

/%, Civil Labeler Manager Tool - Civil Labeler Imperial.xm| — X

HE GO &=

B Cii Labels L2bel  Placement
Cross Secton
Plan - Drainage and Ltities Text Favorite: | Sefect Text Favorite ~| A
Plan - General

Plan - bterseclions

- -

Plan - Land Acq
o)
i Parcel Owner
POB
POC
Plan - Linear
Plan - Paints
Plan - Survey
Profile

B-B-E-E

Select a text favorite to use for label(s).

24) In the Text Favorite Box select the pulldown and choose the plus next to Parcel 6021109 and choose
ARC_RAD_CB_CH.

Label  Placement

Text Favorite: | Safect Taxt Favonite V| A
- Parcel 6021109.dgn

; - ARC_RAD_CB_CH —

+ IDOTCAD_Text Favortes_Text Styles_Dimension Styles.dgnlib

+- Labeler Text Favorites Dimension_Styles_Elem_Temp_Imperial dgnlib

25) In the Element Template Box select the pulldown and choose the plus next to Civil Labeler and choose Plan
Annotation with Arrowhead.

26) Click Save File from the top toolbar in the Civil Labeler Manager dialog and your Civil Label should look like:

P
HE % XX
51~ Civi Labels Label  Placement L
i Cross Seclion F
{1 Plan - Drainage and Lkities Text Favorite: | A ARC_RAD_CB_CH | [Al
(1 Plan - Genera - -
G- Plan - biersecions Element Template: | Plan Annotation with Arrowhead ] [@
B+ Plan - Land Acq Dimension Style: From element template: Plan Annctation vith Arowhesd
4 ARC_RAD_CB_CH
Parcel Owner Text Style: From favorite: 120_Engr Vert_Ctr Ctr
POB
PoC
(1 Plan - Linear
- Plan - Poirts
- Plan - Survey
- Profle
Active : Parcel 602109.dgn = ARC_RAD_CB_CH
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27) Go to the Placement tab in the Civil Label Manager and pick Place at the bottom of the dialog box, pick the Arc
between Station 589+00 to 590+00 drag you label into the position that you want and then Left Click to place it.

Note: You will need to play with the leader option and the Rotation to get the label to place how you would like
it to place. Once you have the label how you want it to make sure to save it again to keep the settings. You may
also have to change the level that the label is placed on.

28) Next, we will use Civil Labeler to label station and offset. Open the Civil Labeler if you closed it. It is located on
the Drawing Production tab. Expand Civil Labels -> Plan = Points then choose Station-Offset.

/B, Civil Labeler Tool - Civil Labeler Imperialxm - #
Bl Civil Labels CivLabelerPlan-Station-Offset
Cross Section
Plan - Drainage and Ltilties Method: ~ Select Elements
Plan - General [ .
Plan - Intersections Leader: |nuto Left Right v‘ Extension: 2.00
Plan -Land Acg Frame: | Nons “ ‘ Offset:
Plan - Linear .
~ Flan - Points Divider: | Aons v
i-[7] Coordinates
i _| Coordinates with Name Use Selection Use Fence
[| Coordinates with Name Descripti
i ] Station Elevation
i | Station-Offset !
H Rotation:
[ Station-Offset-Projected Blevatio ation: (S ¥
L[] Station-Offset-Terrain Blevation
Plan - Survey
Profile
Place Close
AR, = e .-‘::,!,
. || AES AT A

29) Choose Place follow the screen prompts in the lower left corner, identify baseline geometry (PR 1L97) then
Identify elements to label (POB of Parcel 6021109) snap to the element and then drag the label into the position
you want and data point to place it.

\___ Station: 589+28.02
Offset: 10.71' Rt.

580+44.57
140.00' Rt.

Note: We can either edit the Station and Offset with the Text Editor or Build another Text Favorite and Civil
Label to add in other elements to the label.

30) Close the Civil Labeler Tool and with the Element Selector tool active, Double Click on the Station Offset Label
representing the Point of Beginning to open it in the Text Editor. You can edit the text just like any other text

element.
A Text Editor - O X
S Arial 0083 Lt Bot “| ... [y ’ff@ v o0 v fix) || T Arial v ||AT|0.008 +B I ULl _
Z- I e T | C |
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31) Open the Civil Labeler Tool if you closed it earlier and continue using the Station-Offset command to place all
the Station-Offsets.

%

e
PROPOSED ROW & AC LIE

32) Next, we will place all the Bearings-Distances. In the Civil Labeler Tool navigate to Plan - Linear -> Linear —
Bearing and Length. Then click on the Place command, then pick the EX ROW LINE near Station 599+00.

anIEgM 5o
§71°02'59"W 1270.5 o

Station: 602+15.09 '
Offset: 140.00' Rt.

33) You may have to adjust the Distance on the line because it may measure the whole line length because of the
clip mask.
34) Because of tight area you may want to create a table for the Bearing - Length.

Place the Ownership Label on the Parcel

1) Make sure that you are in the IL97 — Plan 1 (drawing model)

2) If the Civil Labeler is not open, then open it and navigate to Civil Labels -> Plan — Land Acq and select the Parcel
Owner label.

3) Inthe lower right corner of the dialog box select Place.

/Z, Civil Labeler Tool - Civil Labeler Imperialxml - x>
= Civil Labels CivLabelerPlan-Survey Parcel Owner
(- Cross Section
- Plan - Drainage and Liliies Method:  Select Elements
56 Fon-nenac ' 200
& Plan - Inersedtions Leader: | Mans ~ | Extension 200
[ Plan - Land Acg Frame: | Rectangle Chamfer ~ Offset
[7] ARC_RAD_CB_CH )
[] Parcel Owner Divider: | Nons ~
[ POB
-[]] PoC Use Selection Use Fence
[~ Plan - Linear
(-1 Plan - Points
- Plan - Survey
& Profile Retation: | Nermal 9
Place Close
A7 e [
- i=r AT A
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4) Select Parcel 6021109 on the left near the proposed right of way line and then Data Point on the parcel line.

5) You can drag the label up near the proposed right of way line.
6) Close Civil Labeler. The label with all the Owner information was typed in earlier in this chapter is shown. You

may need to adjust the text in the Ownership Item Type to get it look good in the box.

FOLUND IRON PIN

7) Continue to Label the Plat until you feel most of the labeling is complete. Below is a screen shot of the Plat with

all the Labeling that we have covered.

\ -

Bf

Heat

W e

|
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Chapter 4 Review

General Information

» The objective of this course is to teach tools and techniques that can be used for developing Right of Way Plans
on roadway projects. In this course you learned how to:

o Reference the existing Right of Way centerline and proposed Right of Way lines
o Create an ORD Parcel from stored SS10 parcel data
o Create a proposed parcel with legal description from stored parcel information from SS10
o Create right of way plan sheets and annotation.

New Concepts

> Apply feature definitions to elements.

Use Geometry Builder to convert the SS10 Parcels to ORD Parcels.

Create Named Boundaries.

Create ROW PLAT

Examine the Drawing View

Placing Annotation in the Drawing View
Finding the Annotation Tools to Annotate the Plat

V VYV V VYV

Skills Checklist

» Create new WorkSet

» Context Sensitive Toolbar:
o Making it appear
o Utilizing the commands

» Understanding / using:
o Feature Definitions
o Project Explorer
o Geometry Editor and Builder
o Text Favorites

» Create Named Boundaries and sheets

Page 118 of 131 OpenRoads Designer CONNECT Edition
Chapter 4 — ROW, Parcels and Plats — EXERCISES



Illinois Department of Transportation
Technology Policy and Support — CADD Support Unit

Notes:

OpenRoads Designer CONNECT Edition
Exercises Manual — Notes Page






Chapter 5

Creating a
Parcel from
Key-In






Tllinois Department of Transportation
Technology Policy and Support — CADD Support Unit

EXERCISES - Chapter 5 - Creating a Parcel from Key-In

The objective of this course is to teach tools and techniques that can be used for Creating Parcels by keying in
the bearing and distance. We will also explore setting points to create Temporary Easements. In this course you will
learn how to establish the existing right of way centerline, how to create the existing right of way lines and how to
create an existing property parcel from record data.
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E5.1 - File Setup, Understanding the Interface, and Extracting Parcels

If you have already worked through the Chapter 2and 3 Exercises you can skip the Design File
Setup steps 2 through 6 below.

Design File Setup - Outside ProjectWise

1) Start OpenRoads Designer
2) Setthe Workspace and Work Set

e The Workspace and Work Set define standards that are used by the software. The Workspaces are set up

during the software installation. In this training we will be using the District WorkSpace, but this could

change depending on software and Workspace Standards updates.

e The following steps will set up the Workset you will be using throughout this training. Internally within IDOT

your CADD Manager will take care of setting up the Workset for the project and everyone’s use.
3) Select District from the WorkSpace pulldown menu then select Create Workset from the WorkSet pulldown

menu.

WorkSpace WorkSet
No WorkSpace * No WorkSet
| Al

= R A
Custom Configuration

Aerial Surveys

Bridge

District «

IDOT Consultant

linAic Tallsne v

= Create WorkSpace
g g
o Configuration Assistant

”‘:_'. DWG WorkSet Wizard

56

WorkSpace ~ WorkSet
District ~ _Template for New WorkSet ~
,O

_Template for New WorkSet

You haven't ¢ ta

Recent Fil

Browse

4) The Create Workset Dialog Box will open, fill in and select the following:

e Name: D69621

e Description: IL97/125 Reconstruction

e From the Template dropdown selection box select: _Template for New WorkSet and click OK to continue.

Create WorkSet X

Name:
Description:

Template:

D69621

IL 97/125 Reconstruction

_Template for New WorkSet

Create Folders Only

= Add a Custom Property ~

Folder locations

Root Folder:
Design Files:
Standard Files:

Standards Subfolders:

ProjectWise Projects
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5) On the right side of the screen, you will see “Properties” select it and then select “Advanced Properties”. Fill in
the Advanced Properties in the Edit WorkSet dialog with the following:

Edit WorkSet X

Contract No.: C94598

County: Sangamon

FAP Type: P.

Route: IL97/125

Scale: 1”=50’

Section: (52X63)
SHEETTITLELINE1: IL97/125
SHEETTITLELINE2: Plan Sheets

Name:

Description:

IL 97/125 Reconstruction

Contract No.
County

FAP Type

Route

Scale

Section
SHEETTITLELINE1
SHEETTITLELINE2

Structure No.

94598
Sangamon
P.
IL97/125
1"=50"
(52X63)
IL97/125
Plan Sheets

SN.

= Add a Custom Property ~

6) Click OK to save and exit the Edit WorkSet dialog box (not shown). These Properties will automatically fill in the
Title Block on all sheets in this project. This is the current workflow, this will be changing with future releases of
the software and IDOTCAD Environment, training will be provided at that time.

7) Select Browse and navigate to the location where you unzipped the dataset files. Select the file IL97_125

Parcels.dgn from the Chapter 5Ta folder and click Open.

Design File Setup - Inside ProjectWise

Specific instructions will be presented during class on how to utilize the Managed Workspace within

ProjectWise. Your CADD Manager will also have more information if needed as well as be setting up the

WorkSet folders for the entire Project.
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Set the Geographic Coordinate System

Before we import the Survey data, we need to ensure the Geographic Coordinate System (GCS) is set correctly.

This enables the software to make automatic adjustments so data from different systems will mesh seamlessly.

Surveyors more than anyone can appreciate the importance of setting the correct Geographic System.

1) Select the Survey Workflow from the drop-down menu.

2) Under the Utilities tab, in the Geographic toolset, select the Coordinate

System tool.

isy
3) Select From Library icon. =

4) In the Library Dialog click the Search tab and type lllinois in the “Search

Text” and hit Enter.

% Select Geographic Coordinate System

Library Search
Search Text ‘Ilhnois\ | [ FindNew ]
(® Any \word O All \words
Key Name Description Units Projection EPSG Code Datum Elipsoid
< >
Cancel

5) Click on the Units column header to sort by it.
6) Select all the “Key Name” Coordinate Systems with units of “US Survey Foot” (Shift pick the top and bottom one)

% Select Geographic Cool

rdinate System

Fy
[t ]
o

Coordinate
Systemn

Library  Search

Search Text ‘Ilhnols

EPS5G:102271

(® Any Word O All Words
Key Name Description
ILHP-E Use HARN/IL.IL-E instead - HARN Ili...
NSRSO7.IL-W NSRS 2007 llincis State Plane, West
NSRSO07.IL-E NSRS 2007 llinois State Plane., East ...
IL83-wW NADS3 llinois State Plane, West Zon
IL83-E NADB2 llincis State Plane. East Zone...
1L83/2011-W NSRS11(NADE3/2011) llinois, West ...
1LB3/2011-E NSRS11{NAD83/2011) linois, East

NAD 1383 HARN StatePlane llincis ...

NADB3(HARN) / llinois East ftUS)
NADSHHARN) / llincis West ftUS)
NADS3 / lincis East ftUS)
NADS3 / llingis West ftUS)

NAD 1983 StatePlane llincis West Fl...

NAD27 / linois East

NAD 1383 StateFlane llincis East FIF...

NAD27 / llincis West

=
Units

METER
METER
METER
METER
METER
METER
METER
Meter

US Sur.
US Sur.
US Sur.
US Sur.
US Sur.
US Sur.
US Sur.
US Sur.

Projection
™
™
™
™

EPSG Code
2730

3436
102672
26771
102671
26772

Datum

HPGN
NSRSO7
NSRS07
NADS3
NADE3
NADB3/2011
NADB3/2011
HPGN
HPGN
HPGN
NADE3
NADS3
NADE3
NAD27
NADB3
NAD27

Hiipsoid
GRS51980
GRS51380
GR51380
GRS1580
GR51380
GR515980
GRS1980
GR51380
GRS51380
GRS51380
GR51380
GRS1580
GR51380
CLRKEE
GR51380
CLRKBE w
>

Add To Favorites

0K

Cancel

7) Select Add to Favorites button at the bottom to add your selection.

§

Survey v

OpenRoads Modeling
OpenRoads Drawing Production
Survey

Geotechnical

Reality Modeling

Drawing

Modeling

Visualization

Drainage and Utilities
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8) Select the Library tab at the top of the Dialog.
9) If “Favorites” is not expanded, click the plus (+) sign next to it to expand. This will show you the coordinate
systems that you picked that apply only to lllinois.
e Also notice that there is an IDOT and IDOT_2021 folder listed with the Favorites folder. The IDOT folder lists
the original District 8 LDP zones per county. The IDOT_2021 folder lists the 33 new LDP zones.

B Select Geographic Coordinate System

Library  Search
B0 Favortes Coordinate System a~n
PSG:26771 - NAD27 / llinois East
EPSG: 102672 ]
26772 - NAD27 / llincis West NAD 1983 StatePlane lllinos |
PSG:102671 - NAD 1983 StatePlane llinois East FIPS 1201 Feet Transverse Mercator
PSG:3444 - NADB3(HARN} / llinais West ftUS) o
PSG:3443 - NADB3(HARN) / llinois East ftUS) ESRI PRJ [AcGIS]
PSG:2436 - NADE3 / llinais West ftUS) US Survey rm,:
H PSG:3435 - NADB3 / llincis East ftUS) 90°10°00.0000"W
DoT 36°40°00.0000"N
1DOT_2021 0.99994118
G Library 2296583.3330
0.0000
Positive X and Y
92°15'00.0000"W
87°4500.0000"W
36°00°00.0000"N
43°00'00.0000°N
~
NADE3
North American Datum of 198]
US Defense Mapping Agency.
NADE3 - no shift required
v
Corcel

10) Double Click on EPSG:102672-NAD 1983 StatePlane lllinois West FIPS 1202 Feet under your Favorites.
11) Close the Geographic Coordinate System Dialog.

Reference Needed information to Current Design

1) Select the Survey Workflow from the drop-down menu. Many of the commands you will use in this exercise are
in the Survey Workflow.

|0penRoads Modeling .| = & [operRoadsModding [ HE € - 22 kX = CA\Users\needhamim\Desktop\LeanneWorkAtHomeFiles_Folders\lz

File Home Terrain Geometry Site Layout Corridors Model Detailing Drawing Production Drawing View

u OpenRoads Modeling ymetn
OpenRoads Drawing Production @ [None + | [Default - Q [ @8-=- * i _a; y b Tabs
e e
* Survey Workflows L= == = + A = Attach E_ _‘L Reports Civil Corridor
< Eo =0 =0 Q0 50 kiploter Tools~ %% ~ G ~ & Analysis* Reports~
H Geotechnical v :
Reality Modeling Attributes Primary Selection Model Analysis and Reporting

Drawing Q? |Nn Feature Definition v ‘g? 4 + A :ﬁ'ﬁ 8 £ ‘7\ X GrGUES | [~

Note: Workflows segment tools into discipline specific groups streamlining the interface. Each Tab

Group further segments the Survey tools to a task-based interface.

2) From the Home tab select the Attach Tools -> References, located in the Primary Group.

LOrraors WITOEl L'etaling Lraw

Dl

Explorer Attach _ : Elermne
Tools » }:"IE * B Selecti

[E| References Sel

!"'i"' f& ﬁ Raster Manager i ’
{3 Point Clouds
#)  Reality Mesh

Gy G
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3) Inthe Reference File Dialog, select Tools -> Attach and attach the following files from the Chapter 3 folder. The
Section Corners.dgn file is already attached but turned off.
e Aerial Topo
e EX_ROW
e PR_ROW
e Existing Alignments in the Existing Alignments folder
e Master PR Alignments in the Proposed Alignments folder
Note: A message box will pop up saying the files do not belong to the current WorkSet. This is fine, so just click
Ok to continue.

£ Alert X

"j Selected file(s) do not belong to the active WorkSet. Do you want to
L] continue?

[] Do not display again.

4) Turn on the display of the Section Corners.dgn file in the Reference dialog so it shows up with the rest of the
references. Close the Reference dialog once all files are displaying.

E5.2 - Creating Parcels with Geometry Builder

1) Find Parcel 6021111, it is the smaller of the 3 parcels we worked in Chapter 3 with the farm on it.
2) Zoom in to the Right Corner of Parcel 6021111 and find Point 3339.

3) Inthe Survey workflow, on the geometry tab, in the Horizontal group, select the arrow next to Complex
Geometry and select Geometry Builder from the drop-down menu.

1 Geometry Drawing Production Drawing Utilities Collaborate View

('-_“ > O ’> I Offsets and Tapers ~ \fd / EEB Open Profil

M A Reverse Curves ¥ #% Set Active F
sports | Lines Arcs  Point ‘_L FVerse Lunve Meodify  Complex N
= v v * =L Spirals ~ v Geometry* b Profile Crez

\

Horizontal Complex By Element

""(‘.A.,\:;/ Z Complex By Pl
1

Define By Best Fit

Geometry Builder

B View 1, Default
fag ~ & 3t = < ,6,
I
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4) Inthe Geometry Builder Tool select the fourth tool over, Add new geometry.
5) Inthe Tool Settings Dialog select add New Geometry.
e Feature Definition: Linear\Right_of_Way\ ROW_PR_Design_and_Parcel_Information

e Name: Parcel 6021111

& ] Geometry Builder Tool - Parcel 6021111.xml

B E% XX

ROW _PR_Design_and_Parcel_Information -a W

Parcel 6021111 m

6) Inthe Geometry Build Tool on the top row select Begin Point and snap to Point 3339. Ensure that you snap to
the point and not the line.

' [+~ | Begin Point

+ Deg Min Sec

Select begin point

7) Inthe first line of the Geometry Builder Toolbox select the bearing box it will populate to a Bearing of
N90~00’00” E and a Distance of 0.000’ see the table below for the values to enter. Tab at each entry to lock in
the value and hit Enter to go to the next line.

8) Enter the Points and Type Options listed below. On the 4™ line you have need set the Type to Arc in order for
the Radius and Arc Length columns to show up.

Line in Dialog Bearing Distance Type Radius Arc Length
1 N73751'08.1” W 241.085’ Line
2 $83740'06.0” W 111.803’ Line
3 N69745'59.9” W 79.880 Line
4 N70701'14.7” W Arc 38282.761’ 339.571’
5 N01715’12.0” E 355.832’ Line
6 $89740'30.0" W 734.108’ Line
7 S01705’25.1" E 550.052’ Line

9) Your newly created Parcel 6021111 should look like:

= ]

£ Geometry Builder Tool - Parcel 602111 1.xml — X
D% XX
ROW_PR_Design_and_ [i|: X: 2401845.256' ¥: 1155320.540° <+ Begin Point
Parcel 6021111 3
e [TT] Bearing ~ Deg Min Sec + Survey Fest s @/}' ‘
G Bearing Distance  Type  Hand  Ac A A Redus L;ﬂ’;m =
»  [Nmstosrw 241085 [Line 0 0 i
SE340U60°W [111803  |Line =]
NGY4559.9'W |79.880 | Line - | Arc Leng - |0000 0 i
NZOOTITW (339570 |Ac 7 | aRc ~ | Arc Length - [3s282761 [am9s7r X
NDT'IS120'W (355832 | Line < Leni 0 0 =
SBI4DNDE [734708  |Line
SOVO525.1°E |550052 | Line
G NOUOODD.0E  |0.000 Line
Place Non-Tangent Complex Civil Element Un-Ruled Place Close
> |I| 5 Begin Point + NoLine = %7 ~ Perimeter=[2412.331'] Area=[340652.5532(7.3202)] Closure=[S83°58'10.8"W 0.001]
Extended -~ |
Default
9/29/2021 9:43:46 AM & Resources v
ppabl
Not Modified OpenRoads Model v
New & Sheet Ind v
Locked cetindex ~

10) Pick the Save As button (Green plus sign) and save Parcel 6021111 in your Chapter 5\Parcels folder.

OpenRoads Designer CONNECT Edition Page 125 of 131
Chapter 5 — Creating Parcel from Key-In — EXERCISES



Illinois Department of Transportation
Technology Policy and Support — CADD Support Unit

E5.3 - Creating ROW with Geometry Builder
1) Continue in the IL97_125 Parcels.dgn and in the Geometry Builder Tool dialog select the Add new geometry
button.
2) Rename the new geometry 6021111 ROW.

:J Geometry Builder Tool - Parcel 6021111.xml

SHEE 2 XX

ROW_PR_Design_and_Parcel_Information - X: 04

Parcel 6021111
6021111 ROW Djj :

3) Select Begin Point and then select point 3339 to begin the Parcel.
4) Inthe Top Row of the Geometry Builder tool on the Right side pick the small down arrow and select the Insert
Line command from the sub-menu.

+- Begin Point
1 5ec = Survey Feet - 7N /(‘é [val yy _

Distance ‘ ~ :>J @ /‘

5) Snap aline from point 3339 to 3340, the Line command will continue allowing you to select the next points.
e Snapto Point 3341.
e Snapto Point 3715
6) Change to the Insert Arc command in the sub-menu shown above.
e Snap to Point 3716 you will see an arc glif show up.
e Snap to the Midpoint of the arc between points 3715 and 3716.
7) Change back to the Insert Line command.
e Snap to Point 4206.
e Snap to Point 4204
8) Change back to the Insert Arc command.
e Snap to Point 4205.
e Snap to the Midpoint of the arc between points 4204 and 4205
9) Change back to the Insert Line command.
e Snap to Point 3339 to close the ROW Parcel and Right Click to exit the command.
10) Click Save in the Geometry Builder dialog to save the ROW take to the Parcel 6021111.xml file and close the
Geometry Builder dialog.
o il ]

1 [exml version="1.0" encoding="UTF-16"2>
§<Geometry3uilderDefinitions>

<GeometryBuilderDefinition name="Parcel 6021111">
<GeometryBuilderInfo featureName="Linear\Right_of_ Way\ROW_PR Design_and Parcel_Information" begX="2401845.2561498" begY="1155320.5
<GeometryBuilderLegs>
<GeometryBuilderLeg dire
<GeometryBuilderLeg di
<GeometryBuilderLeg di
e <GeometryBuilderLeg di
10 <GeometryBuilderLeg di .59267112008656"
11 <GeometryBuilderLeg di .2775129871106"
12 <GeometryBuilderLeg dire . istan .052! pe="Line" i False" isChordD: n="Fals
13 <GeometryBuilderLeg direct " " isClockwise="False" isChordD: ition="False" arcParaml="Radius"
</GecmetryBuilderLegs>
</GeometryBuilderInfo>
</GeometryBuilderDefinition>
<GeometryBuilderDefinition name="6021111 ROW">
<GeometryBuilderInfo featureName="Linear\Right_of_ Way\ROW_PR Design and Parcel_Information" begx="2401845.2561498" begY="1155320.5
<GeometryBuilderLegs>
20 <GeometryBuilderleg di
21 <GeometryBuilderLeg di
22 <GeometryBuilderLeg dire
23 <GeometryBuilderLeg dire
24 <GeometryBuilderLeg dire
25 <GeometryBuilderLeg dire .59266672903949"
26 <GeometryBuilderLeg di .952440789276"

NECSIREN]

.79288895901072"

¥
{THTHIE

"0" distance="0" legType="Line" isClockwise="False" isChordD

'"False" arcParaml="Radius"
.85976117010636" "241.085257286408" legTy] = i

="False" isChord nit
" isChord
" isChordD:
" isChordD:

=1111.803398853537" lagTy,
=179.879823585169" legTyp
339.569890945299" leg

63.0358153155463
725.638719296973" 1

217 <GeometryBuilderLeg di .95108899446404" "54.6856866439561
28 <GeometryBuilderLeg di 4.73138336807947" «¢ ="7.9136943553127"
29 </GeometryBuilderLegs>

30 </GeometryBuilderInfo>

31 | </GeometryBuilderDefinition>

32 '</GeometryBuilderDefinitions>
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E5.4 - Creating Temporary Easement with Civil Accudraw (Cogo Replacement)

1)
2)

3)
4)
5)
6)
7)
8)

9)

Go to File then select New and create a new 2D file named Parcel 6021111.dgn in the Chapter 5 folder.
Set the Geographic Coordinate System (GCS) and then attach the following references.
e Aerial Topo

e EX_ROW
e 1L97_125 Parcels
e PR_ROW

e Section Corners

e Existing Alignments in the Existing Alignments folder

e Master PR Alignments in the Proposed Alignments folder and turn on Live Nesting for this one.

Close the Reference dialog box and do a Fit View to see all the referenced files.

Zoom into the area of Parcel 6021111.

On the Survey workflow, in the geometry tab, in the Horizontal group, select the arrow next to Complex
Geometry and select Geometry Builder from the drop-down menu.

If there is anything listed in the Geometry Builder dialog, select the Delete All Items button, and select Yes in the
dialog that pops up.

Choose Open, if prompted to Save Changes to file select No, and navigate to the Chapter 5\Parcels folder and
select the Parcel 6021111.xml file.

Select Parcel 6021111 in the left-hand pane and then select Place in the lower right corner to place the parcel in
the DGN.

Select 6021111 ROW in the left-hand pane and then Place it in the dgn.

10) Close the Geometry Builder dialog, making sure NOT to save it to the file if prompted.
11) Under the Geometry tab, in the General Tools toolset, select the arrow under Civil Toggles and select Civil

Accudraw.

d Book Analyze Edit Terrain Geometry |

. Import/Export ~ rx L' a C
24X

5% Design El ts v ! «

S S Civil  Reports | Lines Arc

Wy Standards * Toggles *
General 2.2 Civil Accudraw
#"  Activate Rules
/°  Deactivate Rules
%’ RemoveRules
>

4 Deactivate Reference Rules

12) The Civil Accudraw toolbox will open on your screen. To activate the tool, select the first icon and the toolbox

will expand to show more tools.

Note: Civil Accudraw works with standard tool to allow you place points and geometry with precision and
accuracy. This will replace many of the common COGO tools.). Civil Accudraw (CA) is one of the few remaining
“Quirky” tools. It can get “out of synch” especially when you are in a 3D file and clicking on views that point to
different (2D, 3D) models. Most times simply deactivating and reactivating will reset the tool. Occasionally you
will have to close the dialog and reopen it. As you learn to be comfortable with it you will find this minor
annoyance is more than made up for by the power of this tool.

13) Select the Station-Offset tool in the Civil AccuDraw toolbar.
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14) On the Survey workflow, in the Geometry tab, in the Horizontal group, select the arrow next under Point to see
the different Point Commands. Select Point from the drop-down menu.

Note: that the tools Locate Point and Equal Spaced Points have other methods to locate points not covered by
Civil Accudraw. Using a combination of CA and point tools, you should be able to locate any point similar to
using COGO tools.

15

~

In the Point settings dialog set: (Hit Enter after keying in the Description to set the values.)
e Elevation mode: None

e Rotation Mode: None

e Feature Definition: Point\ROW\ROW_Pr_Iron_Pin_Set

e Name: POB TE1

e Description: 4207

Elevation L
Elevation Mode  [None |

Rotation L
Rotation Mode |None i |

Feature -
Feature Definition |RO‘.“.|'_Pr_Iron_F‘in_Set W |
Name [PoB TEY |
Description |42D? |

Note: The station, offset fields are added to the cursor, this is the benefit of CivilAccudraw.

16) Hit Shift + O, or tab to the “Offset” field in the Heads up prompt and hit O, on your keyboard, this is the most
important thing about Civil Accudraw, The Big “O”. Notice how the fields do not change when the cursor is
moved. Inexperienced users will be frustrated by this and believe CA does not work. However, that is not the
case, the tool needs you to define the Ordinate (or reference element). This keystroke suspends the operation
to allow you to define an element by data-pointing of it.

17) Now you can datapoint on the Proposed Alignment IL97 to set it as the ordinate for the tool. Notice how the
fields automatically update the values as the cursor is moved now.

18) In the Station field key-in 596+50.00 hit Enter to lock the value and switch to the offset field. Use the TAB key to
switch fields if necessary.

19) Set the offset to 125.00 hitting Enter to lock the value.

Note: An important thing to notice is the Offset will switch from positive to negative in relation to where the
cursor is located to the Ordinate element (Proposed Alignment) when the enter key is pressed. If set to the
wrong value, you can simply edit the value to correct.

20) Data Point in your screen to place the point at the corner of the Temporary Easement (Point 4207).

21) In the Point settings dialog set the Name to IPS 1 and the Description to 3754.

22) Zoom to the upper left corner of the Temporary Easement and Snap to the Center of Point 3754 to place the
point at that location. Data Point to accept the placement and Reset to clear the command.

ot
o5

Station | EEieiRnY
Offset |-180.000°

Enter Data Point
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23) Using the Element Selection tool select one of the just placed points. Notice the handles indicating that the
values used to place the point are stored within the point. Later if changes are necessary, they can be made
using the values and the points do not need to be deleted/recreated. Data point on your screen to clear the
point from the selection set.

24) Change the mode in Civil Accudraw to XY. }

25) Select the Point command from the Horizontal toolset and in the Point settings dialog set the Name to IPS 2 and
the Description to 3755.

26) On the Heads Up cursor prompts in the X field enter 2401522.711, and hit Enter. In the Y field 1155497.379, and
hit Enter. This will set the XY values of the third point.

27) Data point on your screen to set the third point at the specified XY.

28) For the final point set the Name to IPS 3 and the Description to 4208 in the Point settings dialog.

29) In the X field enter 2401504.850 and hit Enter, in the Y field 1155445.360 and hit Enter.

30) Data point to set the final point and Reset to exit the Point command.

Layout your Parcel using the Placed Points

1) We no longer need the assistance of Civil Accudraw, so we can Deactivate it by selecting the Toggle Civil
Accudraw button at the beginning of the toolbar. Do not make the mistake of simply closing the CA dialog by
clicking on the Red X. This will close the dialog, but will NOT deactivate CA and you will notice the dashed lines
and additional fields attached to the cursor.

~’ O o C@E

Toggle Civil AccuDraw

2) Ensure that your Feature Definition Toolbar is open and docked. If not then you can find it under Geometery tab
-> General Tools -> Standards -> Feature Definition Toolbar.

3) Inthe Feature Definition Toggle Bar, select the Linear\Right_of_Way\
ROW_PR_Design_and_Parcel_Information feature definition from the drop-down menu. Toggle on the Use
Active Feature Definition toggle at the beginning of the toolbar.

e":? ROW_PR_Design_and_Parcel_Information > ‘t

Explorer v X

nd \N

4) In the Survey workflow, on the Geometry tab, in the Horizontal group, select the arrow under Lines and select
Line Between Points tool from the drop-down menu.

Geometry Drawing Production D
2 " Offsets and
-
VAROR

. . A Reverse Cur
yorts Lines Arcs Point

- v =L Spirals ~

" Line Between Points pnt
Line To Element L J
)¢ Line Between Arcs

Line From Elerment

- - F~ Chamfer Between Points l

5) Inthe Line settings dialog enter 6021111 TE in the Name field, and hit Enter to lock the value in.

6) We will start drawing the parcel at the POB TE1 point (4207). Allow AccuSnap to Lock on to the point and Data-
point to start placing a line.

7) Notice how you could place the Temporary Easement using the cursor menu to enter distance and bearing;
however we want to define a relationship between the linework and the points.
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8) Next snap to IPS 1 (3754) and data-point to place the line between the two points.

9) You will need to reselect the tool at each segment, while this may seem annoying at first, understand we are
establishing importing relationships between the line work and points.

10) Repeat the steps as necessary to place lines between:

e IPS1(3754) and IPS 2 (3755)
e IPS2(3755) and IPS 3 (4208)
e IPS 3 (4208)and POB TE1 (4207).

11) Once you have all 4 lines drawn, hit Esc to exit the Line command.

12) Now we will turn the collection of linear segments into an easement using the Complex Geometry tool. In the
Survey workflow, on the Geometry tab, in the Horizontal group, select the arrow under Complex Geometry and
select Complex by Elements tool from the drop-down menu.

¥ Offsets and Tapers * \j,u; P HH Open Profi

1 Reverse Curves ~ Modify € Ell 4% Set Active

A odi omplex

<~ Spirals ~ = Geometry = b Profile Cre
Lioreonts! " Complex By Elernent

vieS M A ,z

Complex By PI

Define By Best Fit

Geometry Builder

Geometry Connector |

13) In the tool setting dialog set the Method to Automatic and Name to 6021111 TE,hit enter to set the values in
the dialog.

14) Hover the cursor over the first segment but do not data-point yet. Hover near the center of the segment and
notice how the segment highlights and an arrow appears. The direction of the arrow is dependent on the
location of the cursor in relation to the center point of the segment. It is IMPORTANT for parcels to have the
start point and direction of the arrow follow the order that you want to appear in the report, so take some care
during this section.

15) Select the first segment near the POB so the arrow points North (clockwise) data point and the entire easement
will highlight. Then Data point again to confirm the Easement. Hit Esc to exit the Complex Geometry command.

Locate First Element

16) In the Survey workflow, on the Geometry tab, in the General Tools group, select the arrow under Reports and
select Legal Report from the drop-down menu.

Edit Terrain Drav

% 2
AN >

U
Civil  Reports  Lines Arcs

yae Geometry | Drawing Production

port ~

:ments ¥

Toggles= =

General Tools

+  Horizontal Point Report

= 2 Spirals ~

Horizontal Geometry Report

Profile Report
Legal Report

Map Check Report

Station Offset Report

Point Feature Station Offset Elevation Repart
Station Base Report

Superelevation Report
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17) Data-point (Left-click) on the Easement shape and then Reset (Right click) to Complete.

18) When prompted to Locate the Parent, data-point on Parcel 6021111

19) When prompted to Locate Primary Reference, data-point on the Proposed Alignment for [L97 .

20) Primary Reference Alignment Bandwidth refers to a point where station offset callouts lose their relevance.
Normally you would set to a couple hundred feet off the alighment in order to pick up all the Station-Offsets.
e Set Input Bandwidth to 250’ and hit Enter to lock in the keyed value and data-point to accept.

21) Reset to skip Locate First Secondary Reference Element (could be used for station/offset from a second
alignment.)

22) The report opens in a separate view/dialog.
Note: if you select HorizontalAlignmentLegalDescriptionReference.xsl the points we placed are reported as well.

Chapter 5 Review

General Information
» The objective of this course is to teach tools and techniques that can be used for developing Parcels for creating
Plats, Plat of Highways or Right or Way Plat. In this course you will learn how to reference in various files for
creating the plats. We also how to create an ORD Parcel from stored SS10 parcel data, by following an existing
parcel with line and tools in Geometry Builder and we also learned how to create points by Station and Offset,
Using Civil Accudraw. We also learned how to set point by coordinates to a field book so that we can stake out
later.

New Concepts

> Apply feature definitions to elements.
Use Geometry Builder to build ORD Parcels.
Civil Accudraw Station and offset

Civil Accudraw by coordinates.

YV V V V

Create a legal description
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Notes:
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